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ПРЕДИСЛОВИЕ  

Методические указания составлены на современном научном уровне и рассчитаны на 

студентов, обладающих достаточной подготовкой по разделам предшествующих дисциплин.  

При подготовке издания учтены основные изменения в методах мониторинга и 

тенденции его развития. Последовательность разделов соответствует логической структуре 

курса. Предлагаемые методические указания включают материал, который используется при 

подготовке и проведении практических занятий.  
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Введение 
Целью работы является усвоение основных навыков при работе с математическим 

пакетом MathCad, ознакомится с методикой решения прикладных задач и их реализацией в 
современных математических пакетах. 

1. Теоретическая часть 
Документ программы MathCad называется рабочим листом. Он содержит объекты: 

формулы и текстовые блоки. В ходе расчетов формулы обрабатываются последовательно, 
слева направо и сверху вниз, а текстовые блоки игнорируются.  

Ввод информации осуществляется в месте расположения курсора. Программа MathCad 
использует три вида курсоров. Если ни один объект не выбран, используется крестообразный 
курсор, определяющий место создания следующего объекта. При вводе формул используется 
уголковый курсор, указывающий текущий элемент выражения. При вводе данных в 
текстовый блок применяется текстовый курсор в виде вертикальной черты. 

1.1 Ввод формул 
Формулы — основные объекты рабочего листа. Новый объект по умолчанию является 

формулой. Чтобы начать ввод формулы, надо установить крестообразный курсор в нужное 
место и начать ввод букв, цифр, знаков операций. При этом создается область формулы, в 
которой появляется уголковый курсор, охватывающий текущий элемент формулы, например 
имя переменной (функции) или число. При вводе бинарного оператора по другую сторону 
знака операции автоматически появляется заполнитель в виде черного прямоугольника. В это 
место вводят очередной операнд. 

Для управления порядком операций используют скобки, которые можно вводить 
вручную. Уголковый курсор позволяет автоматизировать такие действия. Чтобы выделить 
элементы формулы, которые в рамках операции должны рассматриваться как единое целое, 
используют клавишу ПРОБЕЛ. При каждом ее нажатии уголковый курсор «расширяется», 
охватывая элементы формулы, примыкающие к данному. После ввода знака операции 
элементы в пределах уголкового курсора автоматически заключаются в скобки. 

Элементы формул можно вводить с клавиатуры или с помощью специальных панелей 
управления. открывают с помощью меню View (Вид) или кнопками панели управления Math 
(Математика). Для ввода элементов формул предназначены следующие панели: 

 панель управления Arithmetic (Счет) для ввода чисел, знаков типичных математических 
операций и наиболее часто употребляемых стандартных функций; 

 панель управления Evaluation (Вычисление) для ввода операторов вычисления и знаков 
логических операций; 

панель управления Graph (График) для построения графиков; 
панель управления Matrix (Матрица) для ввода векторов и матриц и задания матричных 

операций; 
панель управления Calculus (Исчисление) для задания операций, относящихсяк 

математическому анализу; 
панель управления Greek (Греческий алфавит) для ввода греческих букв (их можно 

также вводить с клавиатуры, если сразу после ввода соответствующего латинского символа 
нажимать сочетание клавиш CTRL+G, например [a][CTRL+G] — a, [W][CTRL+G]-Q); 

панель управления Symbolic (Аналитические вычисления) для управления 
аналитическими преобразованиями. 

Введенное выражение обычно вычисляют или присваивают переменной. Для вывода 
результата выражения используют знак вычисления, который выглядит как знак равенства и 
вводится при помощи кнопки Evaluate Expression (Вычислить выражение) на панели 
инструментов Evaluation (Вычисление). 

Знак присваивания изображается как «:=», а вводится при помощи кнопки Assign Value 
(Присвоить значение) на панели инструментов Evaluation (Вычисление). Слева от знака 
присваивания указывают имя переменной. Оно может содержать латинские и греческие 
буквы, цифры, символы «'», «_», а также описательный индекс. Описательный индекс 
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вводится с помощью символа «> и изображается как нижний индекс, но является частью 
имени переменной, например Vinit. «Настоящие» индексы, определяющие отдельный 
элемент вектора или матрицы, задаются по-другому. 

Переменную, которой присвоено значение, можно использовать далее в документе в 
вычисляемых выражениях. Чтобы узнать значение переменной, следует использовать 
оператор вычисления. 

В следующем примере вычислена площадь круга с радиусом 2 (использованы 
переменные г и s, значение постоянной п определено в программе MathCad по умолчанию). 

 
1.2. Ввод текста 
Текст, помещенный в рабочий лист, содержит комментарии и описания и предназначен 

для ознакомления, а не для использования в расчетах. Программа MathCad определяет 
назначение текущего блока автоматически при первом нажатии клавиши ПРОБЕЛ. Если 
введенный текст не может быть интерпретирован как формула, блок преобразуется в 
текстовый и последующие данные рассматриваются как текст. Создать текстовый блок без 
использования автоматических средств позволяет команда Insert > Text Region (Вставка > 
Текстовый блок). 

Иногда требуется встроить формулу внутрь текстового блока. Для этого служит 
команда Insert > Math Region (Вставка > Формула). 

Форматирование формул и текста 
Для форматирования формул и текста в программе MathCad используется панель 

инструментов Formatting (Форматирование). С ее помощью можно индивидуально 
отформатировать любую формулу или текстовый блок, задав гарнитуру и размер шрифта, а 
также полужирное, курсивное или подчеркнутое начертание символов. В текстовых блоках 
можно также задавать тип выравнивания и применять маркированные и нумерованные 
списки. 

В качестве средств автоматизации используются стили оформления. Выбрать стиль 
оформления текстового блока или элемента формулы можно из списка Style (Стиль) на 
панели инструментов Formatting (Форматирование). Для формул и текстовых блоков 
применяются разные наборы стилей. 

Чтобы изменить стиль оформления формулы или создать новый стиль, используется 
команда Format > Equation (Формат > Выражение). Изменение стандартных стилей Variables 
(Переменные) и Constants (Константы) влияет на отображение формул по всему документу. 
Стиль оформления имени переменной учитывается при ее определении. Так, переменные 
хил; рассматриваются как различные и не взаимозаменяемы. При оформлении текстовых 
блоков можно использовать более обширный набор стилей. Настройка стилей текстовых 
блоков производится при помощи команды Format > Style (Формат > Стиль). 

1.3. Стандартные и пользовательские функции 
Произвольные зависимости между входными и выходными параметрами задаются при 

помощи функций. Функции принимают набор параметров и возвращают значение, скалярное 
или векторное (матричное). В формулах можно использовать стандартные встроенные 
функции, а также функции, определенные пользователем. 

Чтобы использовать функцию в выражении, надо определить значения входных 
параметров в скобках после имени функции. Имена простейших математических функций 
можно ввести с панели инструментов Arithmetic (Счет). Информацию о других функциях 
можно почерпнуть в справочной системе. Вставить в выражение стандартную функцию 
можно при помощи команды Insert > Function (Вставка > Функция). В диалоговом окне Insert 
Function (Вставка функции) слева выбирается категория, к которой относится функция, а 
справа — конкретная функция. В нижней части окна выдается информация о выбранной 
функции. При вводе функции через это диалоговое окно автоматически добавляются скобки 
и заполнители для значений параметров. 
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Пользовательские функции должны быть сначала определены. Определение задается 
при помощи оператора присваивания. В левой части указывается имя пользовательской 
функции и, в скобках, формальные параметры — переменные, от которых она зависит. 
Справа от знака присваивания эти переменные должны использоваться в выражении. При 
использовании пользовательской функции в последующих формулах ее имя вводят вручную. 
В диалоговом окне Insert Function (Вставка функции) оно не отображается. 

 
Лабораторная работа №1. Простые вычисления с использованием программы 
MathCad 
 

Задача. Найти ребро куба, равновеликого шару, площадь поверхности которого равна 
площади боковой поверхности прямого кругового конуса, у которого высота вдвое меньше, 
чем длина образующей. Объем этого конуса равен 1. 

Анализ. Основные геометрические формулы, используемые при расчете. 

Объем конуса —
hrV 2

3
1π=

. 
Площадь боковой поверхности конуса — rlS π= . 
Соотношение в конусе между радиусом основания, высотой и длиной образующей —

222 lhr =+ . 
Площадь поверхности шара —

24 RV π= . 

      Объем шара —
3

3
4 RV π=

. Объем куба -
3aV = . 

Откройте панель инструментов Arithmetic (Счет) щелчком на кнопке ArithmeticToolbar 
(Панель инструментов Счет) на панели инструментов Math (Математика) илис помощью 
команды View > Toolbars > Arithmetic (Вид > Панели инструментов > Счет). 

Для удобства расчета будем обозначать каждую из вычисляемых величин отдельной 
переменной. Объем конуса обозначим как V и присвоим ему значение l.Оператор 
присваивания вводится символом «> или кнопкой Assign Value (Присвоить значение) на 
панели инструментов Arithmetic (Счет). Итак, надо ввести В документе появится 
полноценный оператор присваивания: 

V:=1. 
Путем несложных преобразований получим, что радиус основания конуса можно 

вычислить по формуле 

3 3
π
⋅

=
Vr

 
Вводить эту формулу следует слева направо. Порядок ввода этой формулы следующий: 

Сначала вводим знак корня произвольной степени: кнопка Nth Root (Корень данной степени) 
на панели инструментов Arithmetic (Счет) или комбинация клавиш CTRL+\. Щелкните на 
черном квадратике, стоящем на месте показателя степени, и введите цифру 3. Щелкните на 
квадратике, замещающем подкоренное выражение, нажмите клавиши [V][*]. Введите знак 
квадратного корня: кнопка Square Root (Квадратный корень) на панели инструментов 
Arithmetic или клавиша [\] — и цифру 3. Прежде чем вводить знаменатель, дважды нажмите 
клавишу ПРОБЕЛ. Обратите внимание на синий уголок, который указывает на текущее 
выражение. Предполагается, что знак операции связывает выбранное выражение со 
следующим. В данном случае это безразлично, но в целом этот прием позволяет вводить 
сложные формулы, избегая ручного ввода дополнительных скобок. Нажмите клавишу [/]. 
Чтобы ввести число я, можно воспользоваться комбинацией клавиш CTRL+SHIFT+P или 
соответствующей кнопкой на панели инструментов Arithmetic (Счет). 
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На экране появится следующая надпись: 
3 3

π
⋅

=
Vr

. 
5. Введите формулы для вычисления длины образующей и площади боковой 

поверхности конуса: 

3
2⋅

=
rl

;    lrS ⋅⋅= π . 
Указание знака умножения между, переменными обязательно, так как иначе MathCad 

сочтет, что указана одна переменная с именем из нескольких букв. 

Для вычисления радиуса шара R введите формулу π4
SR =

. 

Для вычисления объема шара введите формулу
3

3
4 RW π=

. 
Использовать переменную V  во второй раз не следует, так как теперь мы определяем 

совершенно другой объем. 
 

8. Заключительная формула  
3 wa =  позволит получить окончательный 

результат. После этого снова наберите имя переменной а и нажмите клавишу = или щелкните 
на кнопке Evaluate Expression (Вычислить выражение) на панели инструментов Arithmetic 
(Счет). После формулы появится знак равенства и вычисленныйрезультат. 

a=0.7102 
Вычислять можно как действительные, так и комплексные выражения. Обозначение 

мнимой единицы (i) следует вводить непосредственно после числового коэффициента, 
который нельзя опускать, даже если он равен единице. 

Вернитесь к самому первому выражению и отредактируйте его. Вместо значения 1 
присвойте переменной значение 8. Сразу же перейдите к последней введенной формуле и 
обратите внимание, что результат расчета сразу же стал отражать новые начальные данные. 

 
 

Лабораторная работа №2. Физические вычисления с использованием единиц 
измерения 

Постановка задачи. Теплоизолированный космический аппарат, находящийся на орбите 
Земли, имеет на борту приборы с электрической мощностью, которая может изменяться в 
ходе работы от N1 = 75 Вт (дежурный режим) до N2 = 200 Вт (сеанс связи). С целью 
обеспечения предсказуемого теплового режима в теплоизоляции сделано отверстие 
площадью S1 , на которое попадает поток солнечной энергии W=1400 Вт/

2м . Полученная 
энергия излучается аппаратом через это и дополнительное отверстие в теплоизоляции с 
площадью S2 в режиме «черного тела». Каковы должны быть площади отверстий, если 
допустимый диапазон температур для оборудования, расположенного в аппарате, составляет 
20-30 °С? 
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Анализ задачи. Минимальная температура аппаратуры соответствует режиму 
минимального тепловыделения. В этом случае поступающая мощность 

111 NWSQ += Излучаемая мощность )( 21
4

12 SSTQ += σ , где T1 — минимальная допустимая 
температура в градусах Кельвина. В условиях теплового баланса эти мощности должны быть 
равны. 

Режим максимального тепловыделения соответствует максимальной температуре 

аппаратуры. В этом случае )( 21
4

221 SSTNWS +=+ σ . 
Используя два полученных уравнения, получаем: 

)(
)(

4
1

4
2

4
21

4
12

1 TTW
TNTNS

−⋅
−

=
, )(

)()(
4

1
4

2

4
21

4
1212

2 TTW
TNTNNNWS

−⋅
−⋅−−⋅

=
σ

σ

 
Введите значения известных величин, присвоив их переменным с соответствующими 

именами. Вместо нижних индексов используйте просто дополнительную цифру в названии 
переменной. 

W: = 1400 watt/
2m , 

N1:= 75 watt            N2:=200 watt, 
T1:= (20+273) K    T2:= (30+273) K. 
 
Обозначения физических единиц присоединяйте к соответствующим значениям через 

знак умножения. Если нужное обозначение неизвестно, используйте команду Insert > Unit 
(Вставка > Единица измерения). Измеряемая величина выбирается в списке Dimension 
(Размерность), а нужная единица измерения — в спискеUnit (Единица измерения). 

Присвойте_ переменной σ  значение   постоянной   Стефана-Больцмана 

)1067,5( 42
8

Kм
Вm
⋅

⋅ −

 
Чтобы ввести греческую букву, используйте панель инструментов Greek (греческий 

алфавит) или введите соответствующую латинскую букву (в данном случае «s») и сразу же 
нажмите комбинацию клавиш CTRL+G. Так как специальной единицы для размерности этой 
константы не существует, ее следует составить из стандартных единиц методом умножения и 
деления. 

5. Введите полученные в ходе анализа формулы для вычисления площадей 
отверстий, присвоив полученные значения переменным S1 и S2. 

)12(
)2112()12(:2,

)12(
)2112(:1 44

44

44

44

TTW
TNTNNNWS

TTW
TNTNS

−⋅⋅
⋅−⋅⋅−−⋅

=
−⋅

⋅−⋅
=

σ
σ

 
Чтобы увидеть результаты вычислений, введите имя первой из 

рассчитанныхпеременных и нажмите клавишу [=]. Затем проделайте то же самое со 
второйпеременной. 

22 514.12;5679.01 mSmS ==  
Изменение значений параметров, заданных в условии задачи, приводит к 

автоматическому перерасчету формул. В частности, исследуйте, изменяя 
значениепеременной W, как изменяются требования к такому методу терморегуляциипри 
удалении аппарата от Солнца и приближении к нему (на орбите Венеры W=2700Bт/м2; на 
орбите Марса W=500 Bт/м2) 

Обратите внимание, что результат содержит единицы измерения в соответствиис 
системой единиц СИ. Используемая система единиц отображается в диалоговом окне Insert 
Unit (Вставка единиц измерения). 

Чтобы изменить используемую систему единиц, дайте команду Math > Options 
(Математика > Параметры) и в открывшемся диалоговом окне Math Options (Параметры 
расчета) выберите вкладку Unit System (Система единиц). Выберите систему CGS и 
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посмотрите, как изменились результаты (они теперь выражаются в квадратных сантиметрах). 
Если выбрать американскую систему единиц (U.S.), то результат будет выражен в 
квадратных футах. 

 
Лабораторная работа № 3. Решение уравнений и систем 

Для численного поиска корней уравнения в программе MathCad используется функция 
root. Она служит для решения уравнений вида f(x) = 0, где f(x) — выражение, корни которого 
нужно найти, а х — неизвестное. Для поиска корней с помощью функции root, надо 
присвоить искомой переменной начальное значение, а затем вычислить корень при помощи 
вызова функции: R00T(f(x)). Здесь f(x) — функция переменной х, используемой в качестве 
второго параметра. Функция root возвращает значение независимой переменной, 
обращающее функцию f(x) в 0. Например: 

 
Если уравнение имеет несколько корней (как в данном примере), то результат, 

выдаваемый функцией root, зависит от выбранного начального приближения. 
Если надо решить систему уравнений (неравенств), используют так называемый блок 

решения, который начинается с ключевого слова given (дано) и заканчивается вызовом 
функции find (найти). Между ними располагают «логические утверждения», задающие 
ограничения на значения искомых величин, иными словами, уравнения и неравенства. Всем 
переменным, используемым для обозначения неизвестных величин, должны быть заранее 
присвоены начальные значения. 

Чтобы записать уравнение, в котором утверждается, что левая и правая части равны, 
используется знак логического равенства — кнопка Boolean Equals (Логически равно) на 
панели инструментов Evaluation (Вычисление). Другие знаки логических условий также 
можно найти на этой панели. 

Заканчивается блок решения вызовом функции find, у которой в качестве аргументов 
должны быть перечислены искомые величины. Эта функция возвращает вектор, содержащий 
вычисленные значения неизвестных. Например: 

 

 
 
 

Лабораторная работа №4. Работа с матрицами 
Векторы и матрицы рассматриваются в программе MathCad как одномерные и 

двумерные массивы данных. Число строк и столбцов матрицы задается в диалоговом окне 
Insert Matrix (Вставка матрицы), которое открывают командой Insert > Matrix (Вставка > 
Матрица). Вектор задается как матрица, имеющая один столбец. 

После щелчка на кнопке ОК в формулу вставляется матрица, содержащая вместо 
элементов заполнители. Вместо каждого заполнителя надо вставить число, переменную или 
выражение. 

Для матриц определены следующие операции: сложение, умножение на число, 
перемножение и прочие. Допустимо использование матриц вместо скалярных выражений: в 
этом случае предполагается, что указанные действия должны быть применены к каждому 
элементу матрицы, и результат также представляется в виде матрицы. Например, выражение 
М+3, где М— матрица, означает, что к каждому элементу матрицы прибавляется число 3. 
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Если требуется явно указать необходимость поэлементного применения операции к матрице, 
используют знак векторизации, для ввода которого служит кнопка Vectorize (Векторизация) 
на панели инструментов Matrix (Матрица). Например: 

 

                      >обычное произведение матриц. 
— поэлементное произведение матриц с использованием векторизации. 
Для работы с элементами матрицы используют индексы элементов. Нумерация строк и 

столбцов матрицы начинается с нуля. Индекс элемента задается числом, переменной или 
выражением и отображается как нижний индекс. Он вводится после щелчка на кнопке 
Subscript (Индекс) на панели инструментов Matrix (Матрица). 

Пара индексов, определяющих элемент матрицы, разделяется запятой. Иногда 
(например, при построении графиков) требуется выделить вектор, представляющий собой 
столбец матрицы. Номер столбца матрицы отображается как верхний индекс, заключенный в 
угловые скобки, например М<0>. Для его ввода используется кнопка Matrix Column 
(Столбец) на панели инструментов Matrix (Матрица). 

Чтобы задать общую формулу элементов матрицы, используют диапазоны. Диапазон 
фактически представляет собой вектор, содержащий арифметическую прогрессию, 
определенную первым, вторым и последним элементами. Чтобы задать диапазон, следует 
указать значение первого элемента, через запятую значение второго и через точку с запятой 
значение последнего элемента. Точка с запятой при задании диапазона отображается как две 
точки (..). Диапазон можно использовать как значение переменной, например х := 0,001..1 

Если разность прогрессии равна единице (то есть, элементы просто нумеруются), 
значение второго элемента и соответствующую запятую опускают. Например, чтобы 
сформировать по приведенной выше формуле матрицу размером 6x6, перед этой формулой 
надо указать i := 0..5 j := 0..5. При формировании матрицы путем присвоения значения ее 
элементам, размеры матрицы можно не задавать заранее. Всем неопределенным элементам 
автоматически присваиваются нулевые значения. Например, формула М5 5 := 1 создает 
матрицу М размером 6x6, у которой все элементы, кроме расположенного в правом нижнем 
углу, равны 0. 

Векторы и матрицы. 

Задача. Разложить вектор по 














=

1
1
1

V


нормированным собственным векторам матрицы 

















−
=

112
162
221

M

. 
Анализ. Первый этап решения задачи состоит в нахождении собственных значений и 

собственных векторов данной матрицы. Затем необходимо найти вектор T


такой что VTS


=⋅ , 
где S — матрица, столбцы которой представляют собой собственные вектора матрицы М. 

1. Запустите программу MathCad. 
2.Создайте матрицу М. Начните запись оператора присваивания, а для ввода правой 

части нажмите комбинацию клавиш CTRL+M, воспользуйтесь командой Insert >Matrix 
(Вставка > Матрица) или щелкните на кнопке Matrix or Vector (Матрицаили вектор) на 
панели инструментов Matrix (Матрица). 
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3.В открывшемся диалоговом окне Insert Matrix (Вставка матрицы) укажите число строк 
и столбцов (по три) и щелкните на кнопке ОК. 

4.Введите значения элементов матрицы в отведенные места.  
5.Аналогичным образом сформируйте векторV


. Он будет представлять собойматрицу, 

имеющую только один столбец. 
6.Собственные значения квадратной матрицы можно получить при помощи функции 

eigenvals. Результатом ее работы является вектор собственных значений, присвойте его 
переменной L. 

7.Функция eigenvec позволяет получить собственный вектор, соответствующийданному 
собственному значению. Ей нужны два параметра: матрица, для которой ищется собственный 
вектор, и собственное значение, которому он соответствует. Чтобы записать собственные 
вектора в качестве столбцов матрицы S, надо присвоить вычисленное значение столбцу 
матрицы. Столбцы матрицы в программе MathCad выбираются специальным верхним 
индексом, заключенным в угловые скобки. Чтобы ввести номер столбца, нажмите 
комбинацию клавиш CTRL+6 или щелкните на кнопке Matrix Column (Столбец) на панели 
инструментов Matrix (Матрица), после чего введите номер нужного столбца матрицы. Будьте 
внимательны — столбцы и строки матрицы нумеруются начиная с нуля. 

S<0> 
8. В правой части оператора присваивания надо указать собственное значениематрицы. 

Собственные значения являются элементами вектора L. Номер элемента указывается как 
нижний индекс. Для ввода нижнего индекса нажмите клавишу [ или воспользуйтесь кнопкой 
Subscript (Индекс) на панели инструментов Matrix. Итоговый оператор для первого 
собственного вектора будет выглядетьследующим образом: 

S<0>:=eigenvec(M,L0). 
Аналогично задайте операторы для второго и третьего собственных значений. 
9. Для нахождения коэффициентов при собственных векторах в разложении 

необходимо решить систему линейных уравнений. Ее удобно записать в матричнойформе. 
Создайте вектор Т с  тремя элементами. Величины этих элементов значения не имеют. 

Запишите ключевое слово given. 
Ниже запишите матричное уравнение ST=V .Знак логического равенства введите с 

помощью комбинации клавиш CTRL+=. 
Найдите коэффициенты в разложении при помощи функции find. 
















=

4606.1
4472.0
1865.0

)(Tfind

 
 
∆ Мы научились производить операции с векторами и матрицами, использовать 

соответствующие функции, выделять столбцы матриц и отдельные элементы. Матричная 
запись часто позволяет представить задачу в более удобной форме. 

 
 

Лабораторная работа № 5. Аналитические вычисления 
 

Задача 1. На приведенной схеме сопротивление RR является переменным. Определить, 
как меняется ток между точками А и В в зависимости от величины этого сопротивления. 
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Анализ. Перенумеровав сопротивления в указанном порядке и воспользовавшись 

законами Кирхгофа, получим систему уравнений, позволяющую найти величины токов. 
 

 
 
Эту систему надо решить, не подставляя конкретных 

значений вместо параметров R, RR и Е. 
Запустите программу MathCad. 
Введите ключевое слово given. 
3. Введите уравнения системы, полученной в ходе анализа. 

Обозначьте неизвестныетоки переменными I0,I1,I2,I3,I4. Фиксированное сопротивление R 
обозначьтепеременной R0. Обратите внимание, что присваивать начальные значения 
токовили задавать значения переменных R0,RR и E не требуется. 

4.Введите функцию find, перечислив в качестве параметров неизвестные I0,I1,I2,I3,I4. 
Затем введите оператор аналитического вычисления, который выглядиткак стрелка, 
направленная вправо, и вводится комбинацией клавиш CTRL+. иликнопкой Evaluate 
Symbolically (Вычислить аналитически) на панели инструментовEvaluation (Вычисление). 

5.Щелкните за пределами данного блока, и программа MathCad произведет 
аналитическое решение системы уравнений. 


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   Полученный результат позволяет провести полный анализ схемы. Задача 2. Найти все 

корни уравнения: 
(1+y-y2)2+y=2 
Анализ. Это уравнение четвертого порядка. Легко подобрать один корень (у = 1). 

Остающееся уравнение третьего порядка не имеет рациональных корней, так что поиск 
других корней этого уравнения — дело непростое. Неясно даже, сколько еще действительных 


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


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
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
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корней имеет данное уравнение. Результаты численного решения зависят от подбора 
начального приближения и поэтому не гарантируют отыскания всех корней уравнения. Мы 
же решим это уравнение аналитически. 

Введите заданное уравнение. Чтобы раскрыть скобки, дайте команду Symbolics 
>Simplify (Аналитические вычисления >Упростить). 

Выделите в полученном уравнении независимую переменную (в данном случае y) и 
дайте команду Symbolics > Variable > Solve (Аналитические вычисления >Переменная > 
Решить). 

Программа MathCad выдаст вектор, элементами которого являются корни данного 
уравнения. 

Полученный результат содержит сложные комплексные радикалы, и его невозможно 
применить с пользой (нельзя даже точно сказать, являются ли корнидействительными или 
комплексными). Чтобы разделить действительную имнимую части, выделите результат 
вычисления целиком и дайте командуSymbolics > Evaluate > Complex (Аналитические 
вычисления > Вычислить > В комплексном виде). В результате запись станет более простой, 
но результат все-такиостанется трудным для восприятия. 

Следующий шаг — раскрытие скобок, в данном случае упрощение 
аргументовтригонометрических функций. Для этого примените команду Symbolics > 
Expand(Аналитические вычисления >Раскрыть). Только теперь станет ясно, что все 
корниуравнения действительные (все мнимые компоненты сократятся). Это наилучшая 
точная запись решения, которую можно получить с помощью программы MathCad. 

10. Чтобы получить результат в числовом виде, достаточно ввести в конце выражения 
(итогового или на любой из предыдущих стадий) команду вычисления (=). 
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Лабораторная работа №6 Построение графиков 

Чтобы достроить двумерный график в координатных осях Х- Y, надо дать команду 
Insert > Graph > X-Y Plot (Вставка > График > Декартовы координаты). В области размещения 
графика находятся заполнители для указания отображаемых выражений и диапазона 
изменения величин. Заполнитель у середины оси координат предназначен для переменной 
или выражения, отображаемого по этой оси. Обычно используют диапазон или вектор 
значений. Граничные значения по осям выбираются автоматически в соответствии с 
диапазоном изменения величины, но их можно задать и вручную. 

В одной графической области можно построить несколько графиков. Для этого надо у 
соответствующей оси перечислить несколько выражений через запятую. 

Разные кривые изображаются разным цветом, а для форматирования графика надо 
дважды щелкнуть на области графика. Для управления отображением построенных линий 
служит вкладка Traces (Линии) в открывшемся диалоговом окне. Текущий формат каждой 
линии приведен в списке, а под списком расположены элементы управления, позволяющие 
изменять формат. Поле Legend Label (Описание) задает описание линии, которое 
отображается только при сбросе флажка Hide Legend (Скрыть описание). Список Symbol 
(Символ) позволяет выбрать маркеры для отдельных точек, список Line (Тип линии) задает 
тип линии, список Color (Цвет) — цвет. Список Туре (Тип) определяет способ связи 
отдельных точек, а список Width (Толщина)—толщину линии. 

Точно так же можно построить и отформатировать график в полярных координатах. 
Для его построения надо дать команду Insert > Graph > Polar Plot (Вставка > График > 
Полярные координаты). 
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Для построения простейшего трехмерного графика, необходимо задать матрицу 
значений. Отобразить эту матрицу можно в виде поверхности — Insert > Graph > Surface Plot 
(Вставка > График > Поверхность), столбчатой диаграммы — Insert > Graph > 3D Bar Plot 
(Вставка > График > Столбчатая диаграмма) или линий уровня — Insert > Graph > Contour 
Plot (Вставка > График > Линии уровня). 

Для отображения векторного поля при помощи команды Insert > Graph > Vector Field 
Plot (Вставка > График > Поле векторов) значения матрицы должны быть комплексными. В 
этом случае в каждой точке графика отображается вектор с координатами, равными 
действительной и мнимой частям элемента матрицы. Во всех этих случаях после создания 
области графика необходимо указать вместо заполнителя имя матрицы, содержащей 
необходимые значения. 

Для построения параметрического точечного графика командой Insert > Graph > 3D 
Scatter Plot (Вставка > График > Точки в пространстве) необходимо задать три вектора с 
одинаковым числом элементов, которые соответствуют х-, у- и z-координатам точек, 
отображаемых на графике. В области графика эти три вектора указываются внутри скобок 
через запятую. 

Аналогичным образом можно построить поверхность, заданную параметрически. Для 
этого надо задать три матрицы, содержащие, соответственно, х-, у- и г-координаты точек 
поверхности. Теперь надо дать команду построения поверхности Insert > Graph > Surface Plot 
(Вставка > График > Поверхность) и указать в области графика эти три матрицы в скобках и 
через запятую. Таким образом можно построить практически любую криволинейную 
поверхность (например представленную на рис. 1), в том числе с самопересечениями. 

 
Рис.1 Пятикратно перекрученная замкнутая лента, заданная параметрически 
 
Задача. Используя результаты, полученные в предыдущем упражнении, построить 

график, отображающий экспериментальные данные и аппроксимирующую зависимость. 
Построить другой график, отображающий величину отклонения экспериментальных 
значений от аппроксимирующей прямой. 

Анализ. Для построения графика можно использовать функцию, заданную набором 
данных или формулой. Формулы для функций, полученных в результате проделанных 
расчетов, необходимо определить, прежде чем их можно будет использовать при построении 
графика. 

Запустите программу MathCad. 
Загрузите документ, созданный в предыдущем упражнении. 
Переместите точку ввода в нижнюю часть документа. 
Запишите формулу функции r(x) для определения координат точек, лежащихна 

аппроксимирующей прямой. Коэффициенты соответствующего уравнениябыли получены в 
предыдущем упражнении. 

r(x):=b0+b1. x. 
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Нажмите клавишу [@], щелкните на кнопке X-Y Plot (Декартовы координаты) напанели 
инструментов Graph (График) или дайте команду Insert > Graph > X-Y Plot(Вставка » График 
> Декартовы координаты). В документе появится область длясоздания графика. 

Вместо заполнителя в нижней части графика укажите в качестве независимой 
переменной первый столбец матрицы data (data<0> или X). 

Вместо заполнителя слева от графика укажите, что по вертикальной оси должны 
откладываться значения из второго столбца матрицы data и определенная выше линейная 
функция r(х). В качестве разделителя используется запятая. Диапазон значений для осей 
координат выбирается программой MathCad автоматически. 

Чтобы изменить вид автоматически построенного графика, дважды щелкните внутри 
него. Откроется диалоговое окно Formatting Currently Selected X-Y Plot(Форматирование 
графика в декартовых координатах). Первая запись в списке на вкладке Traces (Кривые) 
соответствует первой отображенной кривой. Для изменения записи используются поля под 
списком. 

9. Под столбцом Legend Label (Подпись) введите название графика. 
В раскрывающемся списке под столбцом Symbol (Маркер) выберите способ 

обозначения для отдельных точек. 
Под столбцом Туре (Вид линии) укажите, что необходимо пометить отдельныеточки 

(points), а не провести непрерывную линию. 
Выберите в списке вторую кривую и настройте ее отображение по своему вкусу. 
Установите флажок Hide Arguments (Скрыть параметры), чтобы не отображать названия 

осей. 
Сбросьте флажок Hide Legend (Скрыть подписи), чтобы включить отображение 

подграфиком заданных подписей кривых. 
В поле Title (Заголовок) на вкладке Labels (Надписи) задайте название графика 

ивключите режим его отображения: флажок Show Title (Показать заголовок). 

 
Рис. 2. График экспериментальных точек и аппроксимирующей прямой 
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 Постройте график, на котором отображалась бы величина отклонения точекот линии 
приближения (b0+b1. X-Y). Отформатируйте его, используя те жесредства, что и в 
предыдущем случае. 

Заголовок и подписи, использующие русские буквы, могут отображаться неправильно. 
Коррекцию обеспечивает выбор шрифта, правильно воспроизводящего кириллицу. Дайте 
команду Format > Equation (Формат > Выражение), в раскрывающемся списке Style Name 
(Имя стиля) выберите пункт Variables (Переменные) и щелкните на кнопке Modify 
(Изменить). Для задания шрифта используйте поле со списком Шрифт. 

Для построения трехмерных графиков рассмотрим задачу. 
Задача. Изобразить на графике приблизительную форму электронных облаков в атомах. 
Анализ. По современным представлениям электронные уровни в атоме определяются 

четырьмя квантовыми числами. Форма электронного облака определяется двумя из этих 
чисел: 

число l определяет тип орбитали (значения 0-3 соответствуют s-, p-, d- и f- орбиталям ); 
число т определяет магнитный момент электрона и может изменяться в диапазоне от –l 

до l. 
При m=0 форма электронного облака определяется на основе многочленов Лежандра 

первого рода: 
l

l

l

l x
dx
d

l
xP )1(

!2
1)( 2 −⋅
⋅

=
где l — степень многочлена. 

В этом случае
)(cos

4
12)( φ

π
φ PlY ⋅

+
=

 
Параметрическое задание соответствующей поверхности имеет следующий вид: 

φφφθ
θφφφθ
θφφφθ

cos)(),(
sinsin)(),(
cossin)(),(

⋅=
⋅⋅=
⋅⋅=

Yz
Yy
Yx

 
Углы θ, φ   изменяются в диапазоне от 0 до 2π. 
Запустите программу MathCad. 
Определите переменную l , которая укажет тип орбитали. 
l:=3 
3. Построение поверхности будем производить по точкам. Задайте два 

диапазона,которые будут определять изменение параметров θ, φ , задающих 
поверхность.Удобно определить границы диапазона в целых числах (через точку с запятой,на 
экране изображаются две точки), а затем произвести перемасштабированиена отрезок [0; 2 π]. 

100
2:,

100
2:

100..0:,100..0:
πφπθ ⋅=⋅=

==

ji

ji

ji
 

4. Определите двумерные матрицы, определяющие значения координат х, у и z, 
взависимости от значения параметров. Используйте названия переменных ХО,Y0 и Z0. 

)cos()(:0
)sin()sin()(:0
)cos()sin()(:0

))(cos(
4
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Дайте команду Insert > Graph > Surface Plot (Вставка * График > Поверхность) или 
воспользуйтесь кнопкой Surface Plot (Поверхность) на панели инструментовGraph (График) 

 
 Рис.3 Трехмерное изображение электронной f-орбитали 
В появившейся области графика вместо заполнителя укажите имена отображаемых 

матриц через запятую, заключив все их в скобки: (XO,YO,ZO). 
Чтобы изменить формат построенного графика, дважды щелкните на его 

области.Откроется диалоговое окно 3-D Plot Format (Формат трехмерного графика). 
На вкладке General (Общие) установите флажок Equal Scales (Равный масштаб),чтобы 

обеспечить одинаковый масштаб по осям координат. 
На вкладке Appearance (Оформление) установите переключатель Fill Surface(Заливка 

поверхности), чтобы обеспечить заливку построенной поверхности. 
На вкладке Lighting (Подсветка) включите режим освещения поверхности. Установите 

флажок Enable Lighting (Включить подсветку), отключите все источникисвета, кроме 
первого. 

На панели Light Location (Размещение источника) задайте координаты источникасвета. 
Используйте кнопку < Применить>, чтобы сразу видеть последствия сделанных настроек. По 
окончании настройки закройте диалоговое окно щелчком накнопке ОК. 

Путем протягивания мыши в области графика измените направление осей координат, 
чтобы изображение было видно наиболее отчетливо. 

Изменяя значение l, можно увидеть форму электронных облаков для разных орбиталей, 
в том числе и не встречающихся в природе. 

 
Лабораторная работа №7 Анализ результатов испытаний 

Задача. К пружине последовательно подвешивали грузы массой 1, 2, 3, ..., 20 кг. В 
результате был получен список величин удлинения пружины (в миллиметрах). Определить 
основные статистические параметры полученного набора измерений. Рассчитать жесткость 
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пружины и массу узла, использованного для крепления грузов к пружине, воспользовавшись 
методом наименьших квадратов. 

Анализ. Для решения этой задачи достаточно использовать стандартные средства 
статистических вычислений, имеющиеся в программе MathCad. Теоретически, растяжение 
пружины определяется формулой k • х = (т + т0) • g. Если определить статистическими 
методами коэффициенты a и b в уравнении х = а • т + b, то получим: 

k= a
bm

a
g

=0,
. 

1.Запустите программу MathCad. 
2.Введите таблицу данных, предназначенных для статистического анализа, какматрицу 

с двумя столбцами, первый из которых содержит веса грузов, а второй — значения 
растяжения пружины. 

3.Определите число точек в наборах данных с помощью функции rows. 
n:=rows(data)  n=20 
    4.Вычислите среднее растяжение пружины в ходе эксперимента с помощью функции 

mean. 
                    Y:=data<1>  mean(Y)=31.645. 
5.Вычислите медиану значений растяжения пружины при помощи функции median. 
Median(Y)=30.6 
Вычислите среднеквадратичное отклонение и дисперсию величины 

растяженияпружиныпри помощи функции . 
Stdev(Y)=17.4041,  stdev(Y)2=302.9025 
Определите коэффициенты линейного уравнения являющегося наилучшим 

приближением для данных наборов данных. Функция slope позволяет вычислить 
коэффициент наклона прямой, а функция intercept — свободный член. 

                X:=data<0>    
             b0:=entercept(X,Y)   b0=0.0132 
             b1:=slope(X,Y)    b1=3.0126 
8.Определите жесткость пружины: 
k=7.448. 105(H/м) 
9.Определите массу узла крепления: 
m=4.36779(г) 
10. Сохраните созданный документ для использования в следующем упражнении. 
 

Лабораторная работа №8 Решение дифференциальных уравнений 
Задача. Найти функцию у(х), удовлетворяющую дифференциальному уравнению 

xxy
dx
dy cos⋅=+

и имеющую значение 0 при х = 0. 
Анализ. Это простое дифференциальное уравнение допускает точное аналитическое 

решение, однако в данном упражнении предполагается использование стандартной функции 
программы MathCad, осуществляющей численное решение данного уравнения. Результат 
вычислений можно после этого сравнить с точным решением. 

Задайте начальное значение функции как элемент вектора у, размерность 
которогосоответствует числу решаемых уравнений (в данном случае единице): y0 := 0. 

Создайте функцию Т (х, y), которая вычисляет значение производной при заданных 
значениях независимой переменной и неизвестной функции: 

)cos(:),( 0 xxyyxT ⋅+−=  
Определите начальное (точка 0) и конечное значение отрезка интегрирования. 
a:=0, b:=12π. 
Укажите число шагов интегрирования. 
K:=20. 
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Вычислите численное решение уравнения при помощи функции rkfixed. 
Z:=rkfixed (y, a, b, K, T). 

 
Рис.4 Графики численного и точного решения дифференциального уравнения 
Результат вычислений — матрица Z с двумя столбцами, первый из которых содержит 

значения независимой переменной, а второй — соответствующие значения функции. 
Постройте график полученного решения. 
Определите аналитическое решение данного уравнения при тех же начальных условиях. 
Нанесите аналитическую кривую на тот же график и сравните поведение численного и 

точного решения. 
Измените число шагов, на которые делится отрезок интегрирования, и исследуйте, как 

изменяется результат расчета при уменьшении и увеличении этого параметра. 
 
Элементарные функции комплексного переменного. 
Целая положительная степень комплексного числа 
Для того, чтобы ввести мнимую единицу i, наберите на клавиатуре 1i и щелкните 

мышью вне выделяющей рамки 
Для того, чтобы отобразить комплексное число в рабочем документе в алгебраической 

форме, щелкните в панели Symbolic по ключевому слову complex и введите в помеченной 
позиции имя комплексной переменной, и щелкните мышью вне выделяющей рамки 

│W│→4 
arg(W)→x 
Для того, чтобы отобразить комплексное число на комплексной плоскости, щёлкните в 

панели Graph по символу декартова графика, в открывшемся окне графиков введите в 
помеченной позиции возле оси ординат – имена мнимых частей, и щёлкните вне поля 
графиков. 

Для того, чтобы установить стиль изображения, щёлкните по графику дважды и 
посмотрите метки в полях ввода, чтобы понять, как определён стиль изображения для 
приведенного графика.   

f(z):=z4                   z:=l-i 
W:=f(z)                  W complex→-4 
│z│→ 2             ( │z│)4→4 

arg(z)→
⋅

−
4
1

x        4.arg (z)→-x 
Корень n-й степени из комплексного числа 
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Для того, чтобы ввести мнимую единицу i, наберите на клавиатуре 1i и щелкните 
мышью вне выделяющей рамки 

Для того, чтобы отобразить комплексное число в рабочем документе в алгебраической 
форме, щелкните в панели Symbolic по ключевому слову complex и введите в помеченной 
позиции имя комплексной переменной, и щелкните мышью вне выделяющей рамки 

│W│→ 4  

[ ] 







⋅⋅−









2
1

2)22( i
 

arg(W)→arg 
arg(w)=-0.393 
Для того, чтобы отобразить комплексное число на комплексной плоскости, щёлкните в 

панели Graph по символу декартова графика, в открывшемся окне графиков введите в 
помеченной позиции возле оси ординат – имена мнимых частей, и щёлкните вне поля 
графиков. 

Для того, чтобы установить стиль изображения, щёлкните по графику дважды и 
посмотрите метки в полях ввода, чтобы понять, как определён стиль изображения для 
приведенного графика.   

f(z):= 4 z                    z:=16. i 

W:=f(z)                   

W complex→ ( ) ( ) 















−⋅−+ 2
1

2
1

2222 i  

│z│→ 16            [ ]4 z →2 

arg(z)→
⋅
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Лабораторная работа № 9 Решение задач аппроксимации. 
 

Создание матриц и векторов, необходимых для решения задачи МНК, производится по 
общим правилам. В свободном месте рабочего поля документа указывается имена объектов 
со знаком присваивания (см. таблицу). Через пункты меню Математика | Матрицы... 
(Math | Matrices...) вызывается диалог, в котором определяются количество Строк (Rows), 
Столбцов (Columns) и выбирается действие  Создать (Create). Здесь же можно Удалить 
(Delete) или Вставить (Insert) нужное число строк и столбцов. (Доступ к диалогу 
производится также нажатием клавиш [Ctrl] M.)  

Для формирования матрицы W удобно использовать функцию diag. 
 

Имя функции Возвращается... 
diag(V) Диагональная матрица, содержащая по диагонали элементы 

вектора V. 
 
На этапе задания значений над векторами и матрицами можно выполнять следующие 

операции: 
 
Операция Обозначение Клавиши Описание 

Присваивание := : Присваивание значений 
элементам вектора или 
матрицы. 

Нижний индекс 
вектора 

Vn [ Элемент вектора с номером n. 

Нижний индекс 
матрицы 

Mn,m [ ..., ... Элемент матрицы из строки n 
и столбца m. 

Верхний индекс M<n> [Ctrl]6 Извлечение столбца n из M 
(возвращается вектор). 

Векторизация 
M  [Ctrl]- Выполнение  всех операций 

над M поэлементно. 
 
По умолчанию массивы нумеруются с нулевого элемента. Чтобы изменить этот 

порядок, необходимо определить начальное значение встроенной переменной ORIGIN через 
пункт меню Математика | Встроенные переменные... (Math | Built-In Variables...). Можно 
также задать глобальное значение ORIGIN в любом месте документа. Например, чтобы 
установить этот параметр равным 1, необходимо напечатать в рабочем поле ORIGIN~1 (при 
этом в документе отобразится ORIGIN≡1). 

Вычисление значений вектора коэффициентов B = (XT⋅W⋅X)-1⋅XT⋅W⋅Y производится с 
помощью стандартных матричных операций. 
 

Операция Обозначение Клавиши Описание 
Умножение 
матрицы на 
вектор 

M⋅V * Произведение матрицы M на 
вектор V. Число столбцов M 
должно соответствовать числу 
строк V. 

Умножение 
матрицы на 
матрицу 

M1⋅M2 * Произведение матриц M1 и 
M2. Число столбцов M1 
должно соответствовать числу 
строк  M2. 
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Операция Обозначение Клавиши Описание 

Сложение и 
вычитание 

M1+M2  
M1-M2 

+ 
- 

Сложение и вычитание 
соответствующих элементов 
массивов M1 и M2, имеющих 
одинаковую размерность. 

Транспониро-
вание 

MT [Ctrl]1 Транспонирование матрицы 
(вектора) M. 

Степень Mn ^ Целая степень n квадратной 
матрицы M (M-1 - обратная 
матрица). 

 
Пример решения общей линейной задачи МНК в матричной форме дан в приложении 2. 
Для вычисления коэффициентов уравнения, представляющего линейную комбинацию 

произвольных функций, используется стандартная функция linfit. 
 
Имя функции Возвращается... 

linfit(x, y, F) Вектор коэффициентов для линейной комбинации функций из 
вектора F, дающей наилучшую аппроксимацию данных из 
векторов x и y.  

 
Элементами вектора F(x) являются функции, линейно комбинирующие в искомом 

уравнении. Их скалярное произведение на элементы вектора коэффициентов F(x)⋅B даст 
значение аппроксимирующей функции y(x). Пример использования функции linfit при 
определении коэффициентов полиномов различного порядка показан в приложении 3. 

Для определения коэффициентов нелинейного уравнения методом наименьших 
квадратов используется стандартная функция genfit, реализующая итерационную процедуру 
поиска решения. 

 
Имя функции Возвращается... 

genfit(x, y, B0, F) Вектор m коэффициентов 0, ... m-1 функции, дающей 
наилучшую аппроксимацию данных из векторов x и y. F(x, B) - 
функциональный вектор. B0 - вектор начальных приближений 
коэффициентов. 

 
Элементами вектора F(x, B) размерностью m + 1 являются функция f(x,0, ... 0) и её 

m частных производных по параметрам 0, ... m-1. Пример использования функции genfit 
для определения параметров нелинейных функций приведён в приложении 4. 

Нелинейную задачу МНК можно решить также путём минимизации сформированной 
функции невязки с помощью стандартной функции minerr. 

 
Имя функции Возвращается... 

minerr(1, ...m) Значения коэффициентов 1, ... m искомой функции. 
 
До использования этой функции необходимо задать начальные приближения 

коэффициентов и сформировать систему уравнений в блоке Given (см. приложение 5). Число 
уравнений должно быть равно числу неизвестных (для удовлетворения этому требованию в 
блок допустимо включать фиктивные уравнения). Здесь же можно задать ограничения на 
значения коэффициентов. 

Для записи операций соотношения при формировании системы уравнений 
используются следующие комбинации клавиш: 
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Условие Клавиши Условие Клавиши 

x = y [Ctrl]= x ≠ y [Ctrl]3 
x < y > x ≤ y [Ctrl]9 
x > y < x ≥ y [Ctrl]0 

 
 

Работа заключается в построении эмпирических уравнений функции одной переменной 
y(x). Она выполняется студентом индивидуально по заданию, выданному преподавателем. 
Варианты заданий приведены в приложении 1. 

Работа выполняется в следующем порядке. 
1.  Задаётся число наблюдений n. Формируются вектора независимой и зависимой 

переменных x и y и диагональная весовая матрица W размерностью n × n. (По усмотрению 
преподавателя подбор эмпирических уравнений может производиться для разных весовых 
матриц.) 

2.  Набор значений x и y аппроксимируется полиномом степени m. Для этого 
формируются матрица наблюдений X размерность n × m+1 (с учётом единичного столбца). 
Коэффициенты полинома определяются путём решения общей линейной задачи МНК с 
помощью матричных преобразований. Определяются показатели качества аппроксимации Sy 
и Sbj. 

3.  Набор значений x и y аппроксимируется полиномом степени m, который 
представляется в виде линейной комбинации степенных функций. Коэффициенты полинома 
определяются с помощью функции linfit. Определяется показатель качества аппроксимации 
Sy. 

4.  Набор значений x и y аппроксимируется заданной нелинейной зависимостью, 
коэффициенты которой находятся с помощью функции genfit. Определяется показатель 
качества аппроксимации Sy. 

5.  Набор значений x и y аппроксимируется заданной нелинейной зависимостью, 
коэффициенты которой находятся путём минимизации функции невязки с помощью функции 
minerr. Определяется показатель качества аппроксимации Sy. 

6.  Строится график, на который наносятся исходные данные x и y и расчётные 
величины, полученные по аппроксимирующим уравнениям. 
 

Лабораторная работа №10 Программирование в системе Mathcad 
 

Программа в Mathcad - это именованное выражение (функция), составленное из 
нескольких программных операторов, которое имеет следующие преимущества: 

более гибкое, чем обычное выражение (так как программа может использовать 
управляющие структуры  подобно  циклам  и условным  операторам); 

намного проще, чем обычный метод формирования сложного выражения. 
Программирование в Mathcad облегчает решение ряда задач. Это объясняется тем, что 

включенные в систему Mathcad Pro операторы программирования имеют основные 
конструкции языков высокого уровня: 

• оператор программирования Add Line (Добавить строку) предназначен для создания 
блоков выражений. Шаблон этого оператора выглядит так: 

Вертикальная черта означает, что операторы, примыкающие к ней, образуют один блок. 
Чтобы удлинить вертикальную черту и соответственно увеличить число меток, достаточно 
ввести в одну из них оператор Add Line; 

• оператор программирования ← (стрелка влево) служит для присваивания значения 
локальной переменной. Шаблон этого оператора выглядит так: 

■ ←  ■ 
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Например, запись вида а ← 5 означает, что символу присвоено значение 5; 
• условный оператор программирования if (если) служит для ввода в программу 

условия. Шаблон этого оператора выглядит так: 
■  if ■ 
• оператор программирования otherwise (иначе) предназначен для введенияв условие 

дополнительной ветви. Шаблон этого оператора выглядит так: 
■  otherwise 
• оператор программирования for (для) предназначен для создания цикла призаранее 

известном числе итераций. Шаблон этого оператора выглядит так: 
for ■   ■ 
• оператор программирования while (пока) предназначен для создания цикла с условием 

выхода из него. Шаблон этого оператора выглядит так: 
while ■ 
■ 
оператор программирования break (прервать) предназначен для остановки процесса 

выполнения программы; 
оператор программирования continue (продолжить) предназначен для продолжения 

вычислений; 
оператор программирования return (вернуть) предназначен для возвращения к 

выполнению цикла. Шаблон этого оператора выглядит так: 
return ■ 
• оператор программирования on error (на ошибке) предназначен для получения 

сообщения при наличии ошибки в выражении, в котором был размещен данный оператор. 
Шаблон оператора выглядит так: 

■  on error ■  
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КОНТРОЛЬНЫЕ ВОПРОСЫ 
Отличие Mathcad от других аналогичных систем.  
Основные возможности системы, способы запуска системы 
Структура меню.  
Понятие документа в системе Mathcad и области из которых он состоит. 
Условные операторы и особенности их ввода в математическое выражение. 
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Предисловие 

Методические указания составлены на современном научном уровне и рассчитаны на 

студентов, обладающих достаточной подготовкой по разделам предшествующих дисциплин.  

При подготовке издания учтены основные изменения в методах мониторинга и тен-

денции его развития. Последовательность разделов соответствует логической структуре кур-

са. Предлагаемые методические указания включают материал, который используется при 

подготовке и проведении практических занятий. 
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ВВЕДЕНИЕ 

В методическом пособии излагаются основные принципы работы в системе T-FLEX 

CAD, приводятся рекомендации по выполнению 2D чертежной графики для задач проекти-

рования. 

Основные понятия 

Система T-FLEX CAD использует при создании чертежа несколько типов элементов. 

1. Элементы построения формируют каркас чертежа. С ними связаны элементы 

изображения, которые и являются  тем реальным изображением, которое мы хотим в итоге 

получить. К элементам построения относятся линии построения и узлы. Линии построения 

и узлы – основные элементы, формирующие параметрическую модель чертежа. По аналогии 

с черчением их можно сравнить с тонкими карандашными линиями, которые затем обводят-

ся тушью. С помощью задания различных типов линий построения и узлов устанавливается 

взаимосвязь элементов построения и определяется порядок расчета их положения при пара-

метрическом изменении чертежа. Они присутствуют только на экране и не выводятся на 

принтер или плоттер. 

Линии построения – это прямые, окружности, эллипсы, кривые (сплайны), эквиди-

станты и кривые, заданные  функцией. Это базовые элементы параметрической модели в T-

FLEX CAD. Они представляют собой тонкие конструкционные линии, с помощью которых 

вы создаете параметрический каркас вашего чертежа. 

Узлы – точки пересечения линий построения. Узлы являются базовым элементом со-

здания параметрической модели в T-FLEX CAD. Узлы напрямую участвуют в построении 

параметрической модели при задании типов линий построения. 

“Свободный” узел – узел, положение которого определяется абсолютными коорди-

натами.  

“Узел с фрагмента” – узел, который определяется положением фрагмента на черте-

же. 

 

2. Элементы изображения формируют чертеж. К элементам изображения относятся 

линии изображения, размеры, тексты, штриховки, допуски формы и расположения поверх-

ностей, надписи, шероховатости. Они могут “привязываться” к элементам построения. В 

этом случае, при изменении положения линий построения и узлов, элементы изображения 

изменяют свое положение, что и является основной идеей параметризации в T-FLEX CAD. 

Эти элементы составляют изображение чертежа при выводе на принтер и плоттер. 
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Линии изображения  – отрезки, дуги окружностей, окружности, дуги эллипсов, эл-

липсы, кривые. Могут быть различных типов (сплошные основные, сплошные тонкие, штри-

ховые, штрихпунктирные и т.д.). Они привязываются к узлам и линиям построения. 

Штриховки, заливки, штриховки по образцу – замкнутые одноконтурные или мно-

гоконтурные области заполненные различными способами. Контуры штриховок привязыва-

ются к узлам и линиям построения. При изменении положения узлов изменяются контуры 

штриховок. При этом автоматически изменяется заполнение штриховок в соответствии с из-

менением контуров. 

Тексты – однострочная и многострочная текстовая информация, задаваемая в тексто-

вом редакторе и отображаемая на экране различными шрифтами. Положение текстов может 

быть задано в абсолютных координатах, то есть независимо от элементов построения. Тек-

сты могут быть привязаны к линиям построения и узлам. 

Размеры – стандартный элемент оформления чертежей. Состоит из совокупности ли-

ний и текстовой информации. Может быть построен только при наличии линий построения и 

узлов. Система T-FLEX CAD поддерживает простановку размеров нескольких стандартов: 

ЕСКД, ANSI, архитектурный ANSI. Размеры автоматически перестраиваются при парамет-

рическом изменении чертежа. 

Шероховатости – стандартный элемент оформления чертежей. Состоит из совокуп-

ности линий и текстовой информации. Шероховатость может быть привязана в абсолютных 

координатах, к узлу, к линии построения и к размеру. 

Допуски формы и расположения поверхностей – стандартный элемент оформления 

чертежей. Состоит из совокупности линий и текстовой информации. Привязывается только к 

узлу. 

Надписи  – стандартный элемент оформления чертежей. Состоит из совокупности 

линий и текстовой информации. Надпись может быть привязана в абсолютных координатах, 

к узлу, к линии построения. 

К сложным элементам изображения относятся фрагменты и картинки. 

Фрагменты  – чертежи системы T-FLEX CAD, которые могут использоваться в дру-

гих чертежах, для получения составных (сборочных) чертежей. Фрагментом может быть лю-

бой чертеж системы T-FLEX CAD. Под параметрическим фрагментом системы T-FLEX CAD 

понимается чертеж, при нанесении которого на другой чертеж, вы можете задать его поло-

жение и параметры, от которых зависит его изображение. При создании параметрических 

фрагментов необходимо соблюдать определенные правила 
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Картинки – графические изображения чертежей системы T-FLEX CAD  и других си-

стем, сохраненные в различных форматах. Картинки, как и фрагменты, можно использовать 

в других чертежах. При этом изображение картинок будет неизменным, вы можете только 

задать его положение и масштаб изображения 

 

3. К вспомогательным элементам относятся переменные, поля, базы данных, от-

четы, а также некоторые другие служебные данные. 

Переменные – элементы системы, имеющие имя и значение. Значения переменных 

можно изменять. Основное назначение переменных – это использование их значений в каче-

стве параметров линий построения. Например, в качестве параметра прямой, параллельной 

заданной и расположенной от нее на каком-то расстоянии, можно использовать не только 

число, но и переменную. 

Базы данных – таблицы, содержащие информацию в упорядоченном  виде. Базы 

данных используются для хранения информации, необходимой для чертежа.  

Отчеты – текстовые документы, которые создаются с помощью текстового редактора 

системы T-FLEX CAD и могут включать в себя переменные системы. Служат для создания 

разнообразных текстовых документов. 

Одним из главных преимуществ системы T-FLEX CAD (далее система) перед други-

ми CAD-системами является возможность параметризации элементов, составляющих сбо-

рочные чертежи, а также использования её при создании сборочных чертежей конструкций и 

модификации проектировочных заданий, когда необходимо часто изменять конструкторские 

размеры, заменять стандартные изделия и т.д. 

При объединении нескольких 2D-чертежей друг с другом применяют наложение или 

совмещение элементов одного чертежа или элемента модели с элементами другого. Такие 

элементы называются фрагментами. Создание чертежей с помощью фрагментов в ряде слу-

чаев позволяет добиться ряда преимуществ. Во-первых, для сложных чертежей упрощается 

процесс создания, так как можно сначала создать отдельные части этого чертежа, а затем 

объединить их. Во-вторых, если создавать параметрический чертеж на основе деталей, со-

ставляющих его, то при изменении каких-либо параметров сборочного чертежа вы сможете 

одновременно получить и полный набор соответствующих этим параметрам чертежей-

деталей. В-третьих, в качестве фрагментов удобно создавать часто повторяющиеся элементы 

чертежей. 
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2D-фрагменты используются при формировании чертежей. Основной принцип заклю-

чается в том, чтобы использовать единожды построенный параметрический чертёж и встав-

лять его в сборочный чертёж, погасив при этом вспомогательные элементы (размеры, неко-

торые штриховки). 

Все создаваемые файлы чертежей, фрагментов, 3D-моделей в системе принято назы-

вать документами T-FLEX CAD или документами. 

Чертежи, полученные с использованием чертежей-фрагментов, в системе T-Flex CAD 

называют сборочными чертежами или сборками. Данное понятие сборки указывает на то, 

что текущий документ системы получен на основе отдельных чертежей или эскизов  и не-

обязательно должен быть оформлен в соответствии с ЕСКД. 

Сборочные чертежи на основе фрагментов легко преобразовываются при модифика-

ции одного из фрагментов, причём зависимые элементы также преобразовываются. 

 

 
Рисунок 1 – Зависимость между фрагментом и построениями, сделанными на его ос-

нове. 

 

На рисунке 1 корпус подшипника и вал построены по узлам с фрагмента, поэтому при 

изменении параметров фрагмента изменяются все зависимые построения. 

Сборочные чертежи на основе фрагментов позволяют получить полный набор черте-

жей-деталей, которые участвовали в сборочном чертеже. При этом они будут иметь те пара-

метры, которые получились в результате пересчета сборочного чертежа. 

Фрагменты, участвующие в сборке, могут быть переменными, то есть в зависимости 

от каких-либо условий в сборочном чертеже будет участвовать тот или иной фрагмент 

(например, радиальный подшипник будет подменён радиально-упорным в зависимости от 

изменения параметров сборки). 
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Каждый фрагмент может в свою очередь также состоять из отдельных фрагментов 

(резьбы, отверстия, стандартные элементы), причем уровень вложенности фрагментов прак-

тически не ограничен. 

Важно учитывать, что линии и другие элементы фрагмента не являются частью чер-

тежа, в который он включен. Это означает, что на их основе нельзя обычным способом со-

здавать другие элементы, например, размеры. Для того чтобы решить эту проблему, в систе-

ме был создан специальный тип узлов и линий построения. Положение узла с фрагмента 

определяется узлом чертежа, на основе которого он был создан. Положение линии построе-

ния определяется линией изображения фрагмента. Узлы и линии построения, созданные на 

основе фрагмента могут быть использованы для необходимых операций, как и любой другой 

элемент вашего чертежа. Создать узел с фрагмента можно в команде Node, узлы с фрагмен-

тами также могут создаваться автоматически при его включении в ваш чертеж. Создать ли-

нию построения на фрагменте можно в команде Line. 
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ЛАБОРАТОРНАЯ РАБОТА № 1 

СОЗДАНИЕ 2D ЧЕРТЕЖА 
 

При выполнении лабораторной работы необходимо использование дополнительной 

литературы – [3] и «СПРАВКИ» в T-FLEX CAD (<F1>) 

В данном разделе описана последовательность действий, которая необходима для то-

го, что бы создать параметрический чертеж. В процессе создания чертежа дается представ-

ление об основных командах системы и о принципах создания чертежей в системе. 

На рисунке 2 представлен чертеж, который необходимо создать. Это – плита со сквоз-

ным коническим отверстием. Чертеж будет представлен в параметрическом виде, поэтому 

любые модификации будут автоматически отображаться на всех проекциях.  

 

 
Рисунок 2 – Чертёж плиты 

 

Построение главного вида плиты. 

Вначале выполним построения в тонких линиях (линиях построения), сделаем обвод-

ку линиями изображения. Далее, используя линии построения основного вида, достроим две 

проекции, с тем, чтобы они изменялись при изменении основного вида. Используя отноше-

ния между линиями построения, свяжем проекции между собой. Затем нанесем текст и раз-

меры. 

Начнем построения с помощью команды Line: Построить прямую (рисунок 3).  

 

Клавиатура Текстовое меню Пиктограмма 
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<L> “Построить|Прямую”  

 

 
Рисунок 3 

  
Рисунок 4 

 

Выберите пиктограмму  в верхней части автоматического меню, которое располо-

жено в левой части экрана (рисунок 4). Вы увидите перемещение перекрестья при движении 

курсора по полю чертежа. Подведите курсор к нижней части поля чертежа около центра и 

нажмите .Будут созданы пересекающиеся прямые построения и узел в месте их пересече-

ния.  

Учтите, что в последствии для простановки размерных линий потребуется место по 

краям чертежа.  

В T-FLEX CAD команда остается активной до тех пор, пока вы не дадите отмену ко-

манды или не укажете другую команду. 

Отмена режима команды (одно нажатие ) уберет изображение перекрестья, но вы 

по-прежнему остаетесь в команде. После отмены режима построения двух пересекающихся 

прямых подведите курсор к созданной вами вертикальной линии и нажмите  (рисунок 5). 

Линия высветится. Это означает, что мы собираемся построить параллельную линию отно-

сительно вертикальной линии. Это очень важный аспект системы T-FLEX – задание отноше-

ний между элементами построений. Расположим новую линию слева от помеченной верти-

кальной линии при помощи . Это будет левая грань детали. 

Одно нажатие  отменит режим построения параллельных линий, но вы по-прежнему 

останетесь в команде построения прямых. 

Если это не так, то повторите команду Line (возможно где-то совершена ошибка). 

Затем подведите курсор к горизонтальной прямой и нажмите . Выберется прямая 

для построения относительно нее параллельной прямой. Переместите курсор вверх и нажми-

те  для задания верхней грани детали (рисунок 6). 
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Рисунок 5 

 
Рисунок 6 

 

 

Следующий шаг – скруглить угол плиты. 

Для этой цели воспользуемся командой Circle:  

Построить окружность.  

 

Клавиатура Текстовое меню Пиктограмма 

<C> “ПОСТРОИТЬ|ОКРУЖНОСТЬ”  

 

Для изображения скругления верхнего правого угла плиты построим окружность, ка-

сательную к верхней и правой прямым. Переместите курсор к верхней прямой и нажмите 

<L>. 

При этом появится окружность, радиус которой будет динамически изменяться вме-

сте с изменением положения курсора, но при этом она будет касательной к выбранной пря-

мой.  

Это означает, что будет построена окружность, касательная к верхней прямой. Как бы 

мы в дальнейшем не изменяли положение верхней прямой, окружность будет сохранять ка-

сание. 

Затем переместите курсор к правой прямой и снова нажмите <L>. Сейчас окружность 

“привязана” к двум линиям построения и сохраняет касание при перемещениях курсора. 

Нажатие  зафиксирует текущий радиус окружности.  

Постройте окружность так, как показано на рисунке 7. 
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Рисунок 7 

 

Если результат не совпал, то вы можете вызвать команду Undo: 

Отменить изменение.  

Клавиатура 

Функциональная клавиша 
Текстовое меню Пиктограмма 

<U> 

<Alt><BackSpace> 
“Изменить|Отменить” 

 

Вызывая эту команду, вы можете последовательно возвращаться на один шаг назад в 

своих действиях. 

Если вы ошиблись и вызвали команду Undo лишний раз, то вызовите команду REDo: 

Возвратить изменение.  

Клавиатура 

Функциональная клавиша 
Текстовое меню Пиктограмма 

<R><E><D> 

<Ctrl><BackSpace> 
“Изменить|Повторить”  

При этом вы возвратите действие, которое было ошибочно отменено. 

Удалить все линии построения и вернуться к началу создания чертежа вы можете, вы-

звав команду PUrge: 

Удалить лишние построения.  

Клавиатура ТЕКСТОВОЕ МЕНЮ Пиктограмма 

<P><U> “Изменить|Удалить лишние построения”  

Это действие удалит все элементы построения, и можно будет повторить построения. 

Вы также можете удалить отдельный элемент построения, используя команду 

EConstruction: 

Изменить построения.  

Клавиатура Текстовое меню Пиктограмма 
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<E><C> “Изменить|Построения”  

После вызова команды выберите элемент и удалите его с помощью клавиши <Delete> 

на клавиатуре или пиктограммы  в автоменю. 

Теперь можно обвести построенную часть чертежа.  

Для этого создадим линии изображения в команде Graphics: 

Нанести изображение.  

Клавиатура Текстовое меню Пиктограмма 

<G> “Создать|Изображение”  

Заметьте, что если для вызова команды вы пользуетесь пиктограммами или текстовым 

меню, то при этом автоматически прекращается работа предыдущей команды, то есть со-

кращается одно лишнее действие (очистка статусной строки, означающая выход из коман-

ды). 

Начните обводку с верхнего левого угла плиты. Линии изображения автоматически 

привязываются к ближайшему пересечению линий построения. Поэтому достаточно переме-

стить курсор к пересечению и нажать . Курсор при нанесении линии изображения работает 

по принципу “резиновой нити” (рисунок 8). Требуется лишь с помощью курсора выбирать 

узлы или пересечения линий построения. При пересечении в одной точке более двух линий 

построения не рекомендуется использовать для выбора узла клавишу <Enter> или . Реко-

мендуется сначала создавать узлы в точках пересечения линий построения, а затем наносить 

изображение, используя клавишу <N>. При использовании клавиши <Enter> в режиме “сво-

бодного рисования” будет создаваться “свободный” узел (не связанный с линиями построе-

ния). Учтите вышесказанное для избежания ошибок при параметрическом изменении черте-

жа. Переместите курсор к точке касания верхней линии и окружности и нажмите  (рисунок 

9). Отметим, что система T-FLEX автоматически ставит узлы в конечные точки линий изоб-

ражения, если они еще не были там созданы  

Теперь мы хотим направить линию изображения вдоль окружности для построения 

дуги между двумя точками касания. Для этого переместите курсор к окружности и нажмите 

<C>. При этом выделится окружность. Направление дуги будет зависеть от того, в каком ме-

сте вы укажете мышью вблизи второй точки дуги. 

Поставьте курсор чуть выше и правее второй точки касания (рисунок 10).  
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Рисунок 8 

 
Рисунок 9 

 
Рисунок 10 

 
Рисунок 11 

 
Рисунок 12 

 

 

Затем нажмите , и линия изображения будет построена в направлении часовой 

стрелки до второй точки касания, как на рисунке 11. 

Укажите на правый нижний угол плиты, на левый нижний, и завершите построения в 

левом верхнем углу, с которого вы начали обводку. 

Для завершения команды нажмите . Чертеж должен выглядеть как на рисунке 12. 

Если обводка не получилась, то отредактировать линии изображения можно с помо-

щью команды EGraphics: 

Изменить изображение.  

Клавиатура Текстовое меню Пиктограмма 

<E><G> “Изменить|Изображение”  

Переместите курсор к неверно созданной линии и нажмите . При этом линия изоб-

ражения выделится, и вы можете удалить ее клавишей <Delete> или пиктограммой  в ав-

томеню. Повторите эти действия для каждой неверно созданной линии. Если неверно по-

строена целая область, то можно воспользоваться выбором линий изображения с помощью 

окна. Для этого необходимо нажать левую кнопку мыши в одном из углов предполагаемого 

окна и, не отпуская ее, переместить в другой угол. Затем отпустить кнопку мыши. При пере-

мещении курсора вслед за ним должен тянуться прямоугольник из точечных линий. После 

этого будут помечены линии изображения, попадающие в окно, и вы сможете удалить их. 
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Для повторного ввода линий изображения вызовите команду Graphics. Для перерисо-

вки экрана используйте клавишу <F7> в любой момент, если не все линии полностью высве-

чиваются после проведенных изменений. 

После получения нужного изображения, его необходимо сохранить, и перейти к сле-

дующему разделу. 

Сохраняется чертеж с помощью вызова команды SAVE: 

Сохранить чертеж.  

Клавиатура Текстовое меню Пиктограмма 

<S><A> “Файл|Сохранить”  

Сейчас на чертеже использованы 5 элементов построения, определяющих форму и 

размеры детали: левый край, правый край, вверх, низ и радиус скругления.  

Для изменения элементов построения вызовите команду EConstruction: 

Изменить построения.  

Клавиатура Текстовое меню Пиктограмма 

<E><C> “Изменить|Построения”  

Переместите курсор к левой вертикальной прямой и нажмите . При этом прямая бу-

дет выделена цветом. Перемещая курсор слева направо, вы увидите, как вместе с курсором 

перемещается и выделенная прямая. Если вы укажете мышью новое положение прямой, то 

при этом изменится ширина плиты. 

Обратите внимание! Изменение положений элементов построений влечет мгновен-

ное изменение “привязанных” к ним линий изображения. Если вы попробуете изменить по-

ложение правой части плиты, то вся плита будет перемещаться. Это происходит потому, что 

левая часть детали построена относительно правой, поэтому при изменениях правой части 

сохраняется установленное отношение. Но левая часть может двигаться независимо от пра-

вой. Попробуйте то же с другими элементами построения, включая окружность. Вы увидите, 

что, перемещая элементы построения, вы меняете размеры и форму плиты, сохраняя задан-

ные при построении отношения. 

После проверки возможности модификации детали верните чертеж в приблизительно 

исходное состояние, показанное на рисунке 12. 

Создание конического отверстия 

Перейдем к следующему элементу чертежа – коническому отверстию.  
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Рисунок 13 

Вызовите команду Line. Построим в центре плиты отвер-

стие. Выберите пиктограмму  в автоматическом меню, 

подведите курсор к правой границе плиты и выберите с по-

мощью нажатия  вертикальную прямую. После этого но-

вая параллельная прямая будет перемещаться вместе с кур-

сором.  

Зафиксируйте ее положение нажатием  приблизительно посередине между правой и 

левой границей плиты. Нажмите  для отмены режима построения параллельной прямой. 

Аналогично построим прямую, параллельную нижней границе и расположим ее также 

приблизительно посередине. 

Для создания узла в точке пересечения новых линий подведите курсор к их пересече-

нию и нажмите <Пробел>. 

После проведения новых построений на экране вы должны получить изображение, 

аналогичное рисунку 13.  

Затем вызовите команду Circle, подведите курсор к узлу на пересечении построенных 

перекрестных прямых и нажмите . 

Появится окружность, радиус которой будет изменяться в зависимости от положения 

курсора. Зафиксируйте левой клавишей мыши окружность так, чтобы ее диаметр был при-

мерно равен половине высоты детали. Заметьте, что после нажатия на , вы по-прежнему 

находитесь в команде Circle. 

Нажмите на пиктограмму построения концентрической окружности  или на кла-

вишу <О> для построения концентрической окружности. 

Курсор должен быть при этом рядом с первой окружностью. Сделайте вторую окруж-

ность немного больше первой и зафиксируйте ее. Чертеж должен выглядеть как на рисунке 

14. 

Перейдите в команду Graphics, расположите курсор рядом с большой окружностью, 

которую вы только что построили, и нажмите клавишу <C>.  
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Рисунок 14 

Окружность будет обведена сплошной основной линией. 

Затем расположите курсор около меньшей окружности и 

вновь нажмите <C>. 

Обе окружности обведены. 

 

 

Построение второго и третьего вида не является необходимым для построения пара-

метрического чертежа в системе T-FLEX CAD.  

В приводимом примере построение вида сверху и сбоку позволяет продемонстриро-

вать дополнительные преимущества параметрического проектирования в системе T-FLEX 

CAD.  

Поскольку прямые имеют бесконечную длину, можно видеть, что другие виды уже 

частично созданы (боковой вид, вид сверху). 

 

Установление зависимостей для создания конического отверстия. 

Войдите в команду Line и переместите курсор к линии построения, соответствующей 

правой границе плиты. Нажмите . При этом выделится вертикальная линия построения, и 

новая параллельная вертикальная линия будет перемещаться за курсором. Это будет правая 

граница вида справа (рисунок 15).  

Зафиксируйте ее в нужном месте нажатием . Эта линия построена относительно 

правой границы плиты, поэтому если правая граница будет передвинута, то новая линия пе-

реместится на такое же расстояние.  

Для переноса новой линии на другое расстояние следует воспользоваться командой 

редактирования линий и передвинуть линию. Но теперь вновь зафиксированное расстояние 

между видами будет сохраняться при изменении правой границы основного вида плиты. 

Отношения между элементами построения сохраняются постоянно, если только вы не 

захотите изменить эти отношения с помощью опции <М> (модифицировать) в команде из-

менения построений EConstruction. 

Обратите внимание, что вы по-прежнему привязаны к правому краю плиты (соответ-

ствующая линия построения выделена) (рисунок 16). Нажмите один раз  для возврата на 

шаг назад в команде Line. Переместите курсор к прямой, построенной в п. 1.  
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Нажмите <L> или просто укажите курсором рядом.  

Сейчас мы хотим построить прямую, которая будет левым краем нового вида. Эта 

прямая будет построена относительно правой прямой вида спереди. 

Зафиксируйте ее нажатием .  

Рекомендуется использовать правый край детали как базовую линию, а остальные 

вертикальные линии построения строить относительно нее. 
При таком методе построения имеются некоторые преимущества, связанные со зна-

ком относительного расстояния между линиями.  
Перейдем к созданию конического отверстия. 
 
 

  
Рисунок 15 

 
Рисунок 16 

 
Рисунок 17 

 

 
 Рисунок 18 

Задача сводится к построению двух 
прямых, которые были бы параллельны гори-
зонтальной прямой, проходящей через центр 
окружности (рисунок 17). При этом они 
должны соответствовать размерам окружно-
стей. 

Нажмите один раз  для возврата на 
шаг назад в команде Line, поместите курсор 
рядом с горизонтальной прямой, проходящей 
через центр окружности и нажмите <L>. 

Прямая выделится цветом. Отведите 
курсор вверх к точке касания первой окруж-
ности и нажмите <C> (рисунок 18), затем ко 
второй точке касания окружности и нажмите 
<C> (рисунок 17).  

Комбинация <L>,<C> означает по-
строение прямой, параллельной выбранной   

Проделайте описанную последова-
тельность команд четыре раза – для верхних 
и нижних точек касания каждой окружности. 

Теперь у нас есть нужные линии по-
строения для обводки на боковом виде (ри-
сунок 19) 
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Рисунок 19 

 

 

 
Рисунок 20  

Рисунок 21 

 
Воспользуйтесь командой Graphics и обведите 4 угла (рисунок 20). 
Для этого лишь нужно подвести курсор к каждому из углов и нажать . Затем 

нажмите  для отмены выбора узла.  
Далее нанесем две линии, изображающие коническое отверстие (рисунок 21). 

Теперь вид практически закончен, за исключением штриховки 

Создание штриховки во многом аналогично созданию линий изображения. Вызовите 

команду Hatch: 

Нанести штриховку.  

Клавиатура Текстовое меню Пиктограмма 

<H> “Создать|Штриховку”  

Затем переместите курсор к любому узлу в верхней половине вида справа и нажмите 

<N> или . При этом должен выделиться указанный узел. Последовательно выберите узлы 

по контуру верхней половины плиты, который должен быть заштрихован. Когда вы верне-

тесь к начальному узлу, воспользуйтесь клавишей <P> для вызова диалогового окна пара-

метров штриховки.  

Это позволит выбрать тип и масштаб штриховки. Нажмите графическую кнопку [OK] 

или <Enter> на клавиатуре.  При этом выделенная область будет заштрихована (рисунок 22).  

Если параметры штриховки были установлены ранее и вам не требуется их изменять, 

то воспользуйтесь клавишей <End> или пиктограммой  для штриховки выделенной обла-

сти.  
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Проделайте те же действия для штриховки нижней части плиты (рисунок 23).  

В принципе можно было создать не две отдельные штриховки, а одну, состоящую из 

двух контуров. Для этого нужно было задать второй контур сразу после завершения первого, 

а затем уже нажать <End> или пиктограмму  в автоменю.  

 

 
Рисунок 22 

 

 
Рисунок 23 

 

 
Рисунок 24 

 

 
Рисунок 25 

После создания штриховки можно пере-

ходить к виду сверху. 

Вызовите команду Line.  

Выберите нижнюю прямую главного ви-

да для привязки положения вида сверху к глав-

ному  

(рисунок 23). 

Переместите вновь создаваемую прямую 

и зафиксируйте нажатием  под главным ви-

дом. Это будет нижняя линия вида сверху. 

Для отмены режима построения парал-

лельных линий нажмите .  

Поставим себе задачу создать вид сверху 

так, чтобы он был связан с другими видами, то 

есть модификации других видов приводили бы 

к изменениям на виде сверху.  

Простейший способ в проекционном 

черчении связать проекции – построить прямую 

под углом 45 градусов к граничным линиям ви-

да слева и вида сверху. 

Остальные вспомогательные линии стро-

ятся относительно данной прямой.  

Одна из полезных комбинаций в команде 

Line – <L>,<L>. 
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Прямые вида слева и вида сверху пересекаются под прямым углом, то новая линия 

пройдет под требуемым углом 45 градусов. 

В команде Line укажите на крайнюю правую прямую вида слева и нажмите клавишу 

<L>. Прямая выделится. 

Затем сделайте то же самое для нижней прямой вида сверху. Возникнет новая прямая, 

которая проходит через точку пересечения под углом 45 градусов (рисунок 25). 

Пока мы находимся в команде Line можно расставить узлы в любых точках пересече-

ния. Для нас важны те точки пересечения линий построения, которые формируют правую 

границу вида справа и линию под углом 45 градусов, которую мы сейчас создали.  

Когда в команде Line, где вы должны находиться сейчас, вы указываете по очереди 

две прямые (опция <L>), то в результате будет создана новая прямая, которая является осью 

симметрии двух выбранных. Если указанные прямые пересекаются, то новая прямая будет 

биссектрисой угла, образуемого выбранными прямыми. Если использовать эту команду для 

параллельных прямых, то будет создана параллельная прямая, располагающаяся посередине. 

Для построения узлов можно также использовать команду Node: 

Построить узел.  

Клавиатура Текстовое меню Пиктограмма 

<N> “ПОСТРОИТЬ|УЗЕЛ”  

Поставьте курсор в точке пересечения и нажмите клавишу <Пробел> (рисунок 26). 

Вы по-прежнему должны находиться в команде Line.  

 
Рисунок 26 

 

Поставьте курсор и выберите прямую нижней границы вида сверху (рисунок 27). Это 

позволит нам построить прямую, параллельную нижней границе. Переместите курсор к 

только что построенному узлу и нажмите клавишу <N>.  
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При этом создастся прямая, параллельная выбранной и проходящая через указанный 

узел. Теперь вид сверху и вид справа будут параметрически связаны. Для проверки этого 

войдите в команду редактирования линий построения EConstruction. Попробуйте поменять 

положение левой прямой бокового вида. Для этого выберите ее, переместите и зафиксируйте 

в новом положении.  

Заметьте, что при этом изменяется положение соответствующей прямой на виде свер-

ху.  

 
Рисунок 27 

 

Создание линий построения для конического 

отверстия на виде сверху будет происходить так же, 

как в п. 3 создания бокового вида. 

В команде Line выберите вертикальную 

прямую, а затем с помощью клавиши <C> построй-

те 4 прямых, параллельные выбранной и касатель-

ные окружностям (рисунок 28).  

Теперь можно построить все линии изобра-

жения на виде сверху. 

С помощью команды Graphics обведите вид 

сверху по периметру (рисунок 29). Необходимо 

нанести две штриховые линии, соответствующие 

коническому отверстию. В команде Graphics 

нажмите клавишу <P> или пиктограмму  в ав-

томатическом меню. На экране появится диалоговое 

окно параметров линий изображения (рисунок 29). 

Выберите мышкой штриховую линию в меню типов 

линий. 

 
Рисунок 28 

 

Рисунок 29 
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Рисунок 30 

 

 

Рисунок 31 

 

Рисунок 32 

 

Рисунок 33 

 

Нажмите кнопку [OK] для выхода из диалогового окна и создайте две штриховые ли-

нии конического отверстия (рисунок 31). 

Теперь создадим штрих-пунктирные осевые линии. Еще раз нажмите <P> в команде 

Graphics 

Нажмите на кнопку справа от меню типов линий и выберите тип линии с названием 

“Осевая” (рисунок 32).  

Тем самым вы не только зададите штрих-пунктирный тип создаваемых линий, но и 

установите требуемые типы начала и конца линий.  

Создайте 4 осевые линии как показано на рисунок 33. 

Линии построения, которые до сих пор мы использовали, были бесконечными. Для 

удобства работы их можно “обрезать” до крайних узлов. Для этого в команде EConsrtuction 

используйте опцию обрезки. Войдите в команду EConstruction. 

Клавиатура Текстовое меню Пиктограмма 
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<E><C> “Правка|Построения|Линия постр.“  

Если вы выберите одну прямую и нажмете <T> или , то обрежется только эта вы-

бранная прямая.  

Если вы используете комбинацию , то обрежутся все прямые. 

Если вы захотите вернуться обратно к бесконечной длине прямых, то вызовите ко-

манду STatus: 

Задать параметры чертежа.  

Клавиатура Текстовое меню Пиктограмма 

<S><T> “Сервис|Статус…”  

Выберите параметр “Экран|Линии построения|Длина” и задайте значение “По умол-

чанию в бесконечности”.  

Можно в команде EConstruction выбрать нужные линии, нажать клавишу <P> и 

установить соответствующее значение.  

На рисунке 34 представлен чертеж с обрезанными линиями построения. Он менее 

насыщен, хотя все необходимые элементы построения на нем присутствуют. 

Линии построения никогда не выводятся на принтер или плоттер, независимо от их 

длины.  

 

 

Рисунок 34 
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ЛАБОРАТОРНАЯ РАБОТА № 2   

ПРОСТАНОВКА РАЗМЕРОВ НА ЧЕРТЕЖЕ 

 

При выполнении лабораторной работы необходимо использование дополнительной 

литературы – [3] и «СПРАВКИ» в T-FLEX CAD (<F1>) 

Создание линейных размеров. 

Вызовите команду Dimension: 

Нанести размеры.  

Клавиатура Текстовое меню Пиктограмма 

<D> “Создать|Размер”  

Теперь можно выбрать любые две линии построения для простановки линейного или 

углового размера. Выберите две крайние прямые линии на главном виде с помощью . Вы 

увидите как вместе с курсором начал перемещаться появившийся размер. Зафиксируйте его 

положение нажатием . В появившемся на экране диалоговом окне можно задать различные 

значения параметров размера. После установки нужных значений нажмите кнопку [OK], и 

увидите на экране размер. Размер шрифта можно поменять в команде STatus на закладке 

“Шрифт”. На этой закладке устанавливаются параметры шрифта, для тех элементов модели, 

для которых они не заданы. Создайте остальные линейные размеры. 

 

 

Рисунок 35 
 Рисунок 36 

 

Диаметры и радиусы проставляются также просто. В команде Dimension подведите 

курсор к нужной окружности и нажмите <C> или . Окружность выберется, и за курсором 

будет перемещаться изображение размера.  
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Клавишами <R> и <D> или соответствующими пиктограммами  и  в автоменю 

можно переключаться из режима простановки радиуса в режим простановки диаметра и об-

ратно (рисунок 36).  

Клавишей <M> можно задать вид проставляемого размера. Клавиша <Tab> поможет 

вам установить выносную полку в нужном направлении. 

После того, как вы укажете курсором на нужное место, нажмите , и после нажатия 

[OK] в диалоговом окне задания параметров размера на экране появится проставляемый 

размер. Проделайте эту операцию для всех размеров на окружностях (рисунок 36). 

После того, как все основные построения завершены, можно все элементы построения 

“спрятать” с помощью команды SHow: 

Задание уровней отображения.  

Клавиатура Текстовое меню Пиктограмма 

<S><H> “Сервис|Уровни…”  

Эта команда управляет видимостью различных элементов. Видимость элемента зави-

сит от “уровня”, на котором он находится. 

Легче всего представить себе уровни как прозрачные пленки, на которых нанесены 

изображения, и из которых складывается целостная картинка. В системе существует воз-

можность сделать невидимыми один или несколько уровней, оставив только те, которые вы 

хотите видеть. Ваш чертеж может иметь 255 уровней от -126 до 127. 

Все элементы в системе T-FLEX CAD автоматически создаются на уровне “0”. В лю-

бой момент вы можете поменять значение уровня у любого элемента. Поскольку мы в нашем 

примере уровни не изменяли, все созданные элементы попали на уровень “0”. 

После вызова команды на экране появится диалоговое окно, в котором вы можете 

установить диапазон видимых уровней для каждого типа элементов модели (рисунок 37). 
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Рисунок 37 

 

 

Рисунок 38 

 

 

Рисунок 39 

Как вы видите, в настоящий момент 

видимыми являются все элементы, уровень 

которых находится в диапазоне от 0 до 127.  

Установите значения нижнего уровня 

для линий построения и узлов в значение 1, 

как показано на рисунке 38. 

Это означает, что на чертеже будут от-

сутствовать линии построения и узлы, по-

скольку они располагаются на уровне 0.  

Теперь чертеж выглядит, как показано 

на рисунке 39. 

Более простым способом погасить ли-

нии построения и узлы является использова-

ние специальной команды, которая убирает 

или показывает все элементы построения из 

текущего окна. 

Данная команда иногда бывает более 

удобной еще и потому, что она гасит постро-

ения не для всего документа, а только для его 

текущего вида.  

Таким образом, если открыто несколько окон одного чертежа, то в одних элементы 

построения могут присутствовать, а в других – отсутствовать. 

Вызов команды: 

Клавиатура Текстовое меню ПИКТОГРАММА 

<Ctrl><Shift><C> “Вид|Погасить построения”  

Нанесение текста на чертеже 

Нанесем текстовую строку с названием чертежа с команды Text:  

Нанести текст:  
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Клавиатура Текстовое меню Пиктограмма 

<T> “Создать|Текст”  

Текст можно “привязать” к любому элементу построения на чертеже для того, чтобы 

его положение изменялось вместе с изменением положения элементов чертежа. Переместите 

курсор к пересечению вертикальной осевой прямой и верхней прямой на основном виде чер-

тежа. Нажмите <N> для привязки текста к узлу, который находится на пересечении этих 

двух прямых. 

Переместите курсор в точку, где должен располагаться текст и нажмите . На экране 

появится окно текстового редактора. 

 

 

Рисунок 40 

Набейте в нем строку текста “Пример чертежа плиты” и 

нажмите на кнопку [OK] (рисунок 40).  

Если текст расположился не в том месте, где вы планировали, 

то можно легко это поправить. 

Войдите в команду EText: 

Изменить текст.  

Клавиатура Текстовое меню Пиктограмма 

<E><T> “Изменить|Текст”  

Укажите курсором на текст и нажмите . Теперь переместите курсор в нужную пози-

цию и снова нажмите . 

Теперь чертеж завершен. Вы сейчас можете войти в команду редактирования элемен-

тов построения EConstruction и попробовать перемещать линии построения. При этом вы 

можете фиксировать новое положение линий построения как с помощью нажатия , так и с 

помощью нажатия <P> и ввода точного значения положения линии в меню параметров. За-

метьте, что весь чертеж изменяется адекватно вашим действиям, включая размеры. Измене-

ние диаметров конического отверстия моментально отслеживается на двух других проекци-

ях. Штриховка также изменяется вместе с изменением определяющих ее линий.  
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ЛАБОРАТОРНАЯ РАБОТА №3  

РАБОТА С ПАРАМЕТРАМИ И ПЕРЕМЕННЫМИ 

 

При выполнении лабораторной работы необходимо использование дополнительной 

литературы – [3] и «СПРАВКИ» в T-FLEX CAD (<F1>) 

Значения практически всех параметров в меню параметров тех или иных элементов 

можно задавать с использованием переменных и выражений. 

Каждая переменная имеет уникальное имя и значение, которое рассчитывается в со-

ответствии с математическим выражением. Кроме того, переменная имеет комментарий, в 

котором можно указать, что собственно определяет эта переменная (длину или радиус, а мо-

жет быть вообще массу). Переменные  бывают двух типов: вещественные и текстовые. Тип 

переменной определяет, какие значения может принимать данная переменная. Значение ве-

щественной переменной – это число. Значение текстовой переменной – строка символов. 

Выражение в T-FLEX CAD – это математическая формула, содержащая стандартные алгеб-

раические действия, логические действия, условные операции, обращения к математическим 

функциям и функциям T-FLEX CAD. В результате вычисления выражения получается зна-

чение, соответствующее типу переменной. 

В системе T-FLEX CAD переменные можно создавать разными способами, на пример: 

в редакторе переменных команды Variables; при задании и редактировании параметров ли-

ний построения; в текстовом редакторе команды Text. 

Важно отметить, что прежде чем создавать элементы построения вашего чертежа, 

необходимо проанализировать, какие именно отношения между линиями вы хотите задать. 

Ведь именно от этого будут зависеть возможности вашего чертежа к параметрическим изме-

нениям. 

Переменные можно назначать параметрам чертежа, а фактически параметрам линий 

построения (расстояниям, диаметрам и т.д.). Это можно осуществлять и во время создания 

линии построения, и во время ее последующего редактирования. Затем, задавая значения пе-

ременных, можно получать новые варианты чертежа. С помощью простых математических 

формул в редакторе переменных переменные можно связывать между собой. 

При изменении положения какого-либо элемента построения или значения какой-

либо переменной система производит пересчет чертежа и его последующую перерисовку. 

Пересчет производится в соответствии с теми геометрическими отношениями, которые были 

заложены при его создании, а также, исходя из математических связей между переменными.  
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Рисунок 41 

 

 
Рисунок 42 

Как правило, грамотно созданный параметриче-

ский чертеж содержит несколько ключевых (внешних) 

переменных, в зависимости от которых производится 

перерасчет остальных переменных и всего чертежа. 

Назначение элементам чертежа переменных и 

выражений 

На конкретном примере можно увидеть, как эле-

менты оформления могут быть связаны с параметрами 

чертежа и, как изменение параметров чертежа автома-

тически приводит к изменению соответствующих эле-

ментов оформления 

Войдите в команду EConstruction и выберите 

прямую на основном виде (см. чертеж плиты).  

 

Рисунок 43 

 

Эта прямая будет выделена цветом так же, как и та, относительно которой она была 

построена (даже если линии построения спрятаны, их по-прежнему можно выбирать). 

Нажмите клавишу <P> или выберите пиктограмму  в автоматическом меню. На экране 

появится диалоговое окно, которое покажет текущее значение параметра прямой (рисунок 

41). 

Поскольку мы создавали эту прямую как параллельную левой части плиты, этим па-

раметром является расстояние между правой и левой сторонами плиты. Вместо конкретного 

значения можно поставить переменную. Набейте вместо значения имя переменной «W» и 

нажмите <Enter> или [OK] (рисунок 42). 

Появится новое диалоговое окно, в котором от вас потребуется подтвердить значение 

вновь создаваемой переменной (рисунок 43). 

Необходимо отметить, что заглавные и прописные буквы не равны в имени перемен-

ной. Переменная «W» не является переменной «w» 
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Следующим действием вызовите команду Variables: 

Редактор переменных.  

Клавиатура Текстовое меню Пиктограмма 

<V> «Параметры|Переменные»  

 

 

Рисунок 44 

На экране появится окно, в котором 

вы увидите переменную «W» и ее значе-

ние. Измените выражение, задающее зна-

чение переменной, например на «150» и 

нажмите [OK] (рисунок 44).  

 

Прямая переместится в новое положение, соответствующее новому значению ширины 

плиты. 

Используйте аналогичные действия для назначения переменной «H» на верхнюю ли-

нию основного вида.  

Войдите в команду EConstruction, выберите верхнюю линию и нажмите <P>. 

Замените конкретное числовое значение на переменную «H» и подтвердите кнопкой 

[OK] ее текущее значение. Снова войдите в команду Variables. Теперь в редакторе перемен-

ных уже две переменные, и вы можете, меняя их значения, наблюдать за изменением черте-

жа. 

Попробуйте задать выражение. Войдите в команду Variables и поставьте вместо чис-

лового значения «H» выражение «W/2». Это будет означать, что значение «H» будет рав-

няться половине значения «W». Нажмите [OK] для того, чтобы посмотреть на результат ва-

ших действий. Теперь вы можете, меняя только значение «W», автоматически изменять зна-

чение «H» 

Следующим шагом назначим переменную «R» на радиус окружности, сопрягающей 

верхнюю и правую линии главного вида. Для этого в команде EConstruction выберите 

окружность, нажмите <P> и замените конкретное значение на «R». Войдите в редактор пе-

ременных Variables и задайте для этой переменной следующее выражение: 

W < 100 ? 0: 6 
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Это выражение означает, что если «W» меньше, чем 100, то «R» равно 0, в противном 

случае – 6. 

Расшифруем содержимое выражения. Сначала выделим его составные части. 

< – является знаком «меньше чем» 

? – означает «в таком случае» 

: – «в противном случае» 

Полностью выражение выглядит так: 

R = W < 100 ? 0: 6 

Значение «R» равно 0, если «W» < 100, и равно 6, при любом другом значении «W». 

Таким образом, для «R» существует лишь два возможных значения – либо «0», либо «6». 

Проверьте это на вашем чертеже. Задайте переменной «W» значения большие или 

меньшие, чем 100, и посмотрите, что произойдет. Заметьте, что когда радиус скругления ра-

вен «0», радиальный размер автоматически исчезает. Программа сама следит за этим. 

Переменные и тексты 

Тексты создаются в команде Text в текстовом редакторе. Уникальной возможностью 

TFLEX CAD является создание переменных текстов. 

Переменный текст – это текст, внутри которого вы можете использовать веществен-

ные и текстовые переменные. После создания такого текста, если вы будете изменять значе-

ния переменных, которые включены в текст, то соответственно будет изменяться содержи-

мое текста. Расскажем более подробно о создании таких текстов на примере чертежа. 

Постройте чертеж, как показано ниже. Постройте два прямоугольника из линий изоб-

ражения так, чтобы получилась как бы таблица из двух ячеек. При построении левую линию 

построения таблицы постройте как параллельную относительно правого края чертежа. Все 

остальные вертикальные линии построения таблицы постройте как параллельные относи-

тельно левой линии построения таблицы. Используя команду EDimension и опцию <P>, 

установите для размеров параметр “Способ нанесения” в “Нет параметров”. Затем задайте 

соответственно для размеров в параметре “Строки|Текст до” значение “A” и “B”, как показа-

но на рисунке 45.  
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Рисунок 45 

 

После этого войдите в команду Text, привяжите создаваемый текст к любому узлу 

таблицы, расположите курсор в первой строке таблицы и нажмите . Откроется окно тек-

стового редактора, в котором введите следующий текст: А={А}. В результате на экране в 

тексте появится значение выражения. 

Выйдите из редактора. При этом на чертеже в таблице появится текст. 

 

 

Рисунок 46. 

 

 
Рисунок 47 

Таким образом, при использовании переменной в тексте необходимо задавать ее имя в 

фигурных скобках. После выхода из редактора текста вместо имени переменной в фигурных 

скобках подставится ее значение. Кроме имени переменной в фигурных скобках в тексте 

можно задавать выражение. В результате на экране в тексте появится значение выражения. 

Аналогично создайте текст для переменной “B” и расположите его во второй строке 

таблицы. 

 

Рисунок 48 

 

Теперь, изменяя значения переменных в Редакторе Переменных, вы можете увидеть, 

как будет изменяться текст в таблице. При этом следует отметить, что, привязав таблицу к 

правой границе чертежа и привязав тексты в таблице к узлам, вы получили полностью орга-

низованный параметрический чертеж. 

Таким образом, используя несколько основных понятий, можно создавать разнооб-

разные зависимости между переменными. 
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ЛАБОРАТОРНАЯ РАБОТА № 4 

ПРИЕМЫ РАБОТЫ С 2D-ФРАГМЕНТАМИ ДЛЯ ПОЛУЧЕНИЯ СБОРОЧНЫХ ЧЕРТЕ-

ЖЕЙ. 

 

Цель работы: данная лабораторная работа определяет основные приёмы работы с 

фрагментами, необходимыми для более полного использования средств параметризации при 

создании и редактировании сложных сборочных чертежей, а также при создании библиотек 

чертежей. 

 

Основные этапы сборки 

Создание сборочного чертежа в системе T-Flex CAD начинается с подготовки фраг-

ментов для вставки в сборочный чертёж. Процесс подготовки заключается в следующем: 

1. Анализ сборки. 

2. Создание фрагментов. 

3. Создание сборок. 

4. Создание анимации движения сборочного механизма (используется по мере 

необходимости). 

 

Анализ сборки 

Проведение анализа необходимо для избежания неудобств при работе с фрагментами 

сборки, а также для корректной работы системы. 

Под анализом сборки подразумевается оценка степени сложности чертежа, выявление 

элементов сборки (проекции чертежа и т.д.), необходимых для дальнейшего редактирования 

по мере проектирования. Необходимо, также, определиться, на сколько чертёж должен быть 

параметризован, т.е. если создаётся проектировочный чертёж, то возможны большие изме-

нения в размещении элементов сборки, или же особой необходимости в параметризации нет 

(при переводе чертежа в электронный формат или же подготовка метафайла для вставки в 

документы MS Office). В первом случае рекомендуется параметризовать основные размеры, 

отвечающие за расположение проекций и в целом чертежа на листе. Во втором случае можно 

не строить зависимые между собой линии построения, пользуясь командами для работы с 

эскизами. 

Также необходимо выявить, какие из элементов, создаваемых фрагментами, будут по-

ворачиваемыми при вставке в сборку, какие из элементов фрагмента должны прорисовы-
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ваться на сборочном чертеже, а какие нет (например размеры, которые необходимы на дета-

лировочном чертеже не всегда нужны в сборочном чертеже). 

Выявить расстояния между линиями построения, которые необходимо будет изменять 

при вставке в сборку (например, диаметр подшипника, зависящий от диаметра вала). 

 

Создание фрагментов 

Фрагментом может быть любой чертеж системы T-FLEX CAD. Методика построения 

чертежей описана в предыдущих разделах сборника. В этом разделе остановимся лишь на 

некоторых правилах, которые нужно знать при создании параметрических фрагментов для 

вставки в сборку. 

Под параметрическим фрагментом системы T-FLEX CAD понимается чертеж, при 

нанесении которого на другой чертеж, можно задать его положение и параметры, от которых 

зависит его изображение. Примером параметрического фрагмента является болт или под-

шипник, взятый из библиотеки стандартных элементов. 

Вставка фрагментов подразумевает использование системы координат фрагмента, 

называемой локальной системой координат. Локальные системы координат можно создать с 

помощью векторов привязки или точек привязки. 

 

Векторы привязки. 

Вектор привязки определяет способ привязки чертежа и ориентацию чертежа при 

вставке его на другой чертеж в качестве фрагмента. При этом вектором привязки задаётся 

положительное направление оси X локальной системы координат чертежа. Векторов привяз-

ки может быть не более 20. 

Вызовете команду открытия документов T-FLEX CAD: 

 <О> “Открыть документ” 

Меню открытия документов можно отображать в режиме просмотра каталогов с фай-

лами, либо в виде отображения библиотек документов. Переключение режимов осуществля-

ется опцией «Библиотеки/Каталоги» в нижнем левом углу окна (рисунок 49). 
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Рисунок 49 – Открытие библиотек элементов 

Из списка выберите конфигурацию «Лабораторные работы», где из библиотеки 

«Л/р №7-9» откройте файл Поршень.grb (рисунок 50). 

 

 

Рисунок 50 – Фрагмент-поршень 

Для данного фрагмента необходимо создать вектор привязки. Для этого выберете ко-

манду FV: 

Построить вектор привязки 

Клавиатура Текстовое меню Пиктограмма 

<F> <V> “Построения | Вектор привязки”  

После вызова команды необходимо указать направление вектора привязки (рису-

нок 51), отметив мышью необходимые точки, задающие направление вектора привязки при 

вставке в сборку (в сборке ориентацию фрагмента можно изменить). Если для вектора при-

вязки нужно совпадение с осью Х, то после указания начала вектора нажмите «Enter» или 
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пиктограмму  в автоменю. После указания начала и конца вектора привязки появляется 

меню параметров вектора привязки (рисунок 52). 

 

 

 

Рисунок 51 – Создание вектора привяз-

ки 

Рисунок 52 – Параметры вектора 

привязки 

 

Как видно из рисунка 52 во фрагменте использованы размеры, созданные в слое 

«Размерный». Как правило, в сборке размеры не требуются, поэтому их «погашают». Одним 

из способов «погашения» размеров является использование векторов привязки. На рисунке 5 

в поле «Список слоёв» выделен слой «Размерный», а в поле связь со слоями указан параметр 

«Рисовать всё, кроме помеченных». Т.о. этот слой не будет отображён на сборке. 

Это один из способов «погашения» элементов, но не единственный. В отличии от 

других способов (с помощью уровней видимости и слоёв) он позволяет назначать отображе-

ние слоёв в зависимости от использования векторов привязки. Используя один и тот же 

фрагмент, но, привязывая разными векторами можно добиться отображения некоторых эле-

ментов на одной сборке и погашения их на другой. 

После построения вектора привязки сохраните данный документ под именем «Пор-

шень FV.grb» в одну из доступных директорий. Далее этот фрагмент будет участвовать в со-

здании сборки. 

Для редактирования векторов привязки используйте команду EFV: 

Изменить вектор привязки 
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Клавиатура Текстовое меню Пиктограмма 

<E> <F> <V> “Правка | Построения | Вектор привязки”  

Вставка фрагмента с помощью векторов привязки будет рассмотрена при создании 

сборки. 

 

Точки привязки. 

Точки привязки задаются переменными. При этом вертикальным и горизонтальным 

линиям в качестве параметров задаются зарезервированные имена переменных. В дальней-

шем система определяет точку пересечения таких линий как точку привязки фрагмента. То-

чек привязки может быть несколько. 

Фрагменты могут быть поворачиваемыми при вставке в сборку или неповорачивае-

мыми, а также привязываться одной точкой или несколькими. 

При создании точек привязки необходимо руководствоваться определёнными прави-

лами, которые рекомендуется соблюдать в дальнейшем при создании любого чертежа, либо 

пользоваться готовыми шаблонами. 

Для создания точек привязки система использует зарезервированные переменные x1, 

y1; x2, y2…x9, y9 – это координаты линий построения, заданные переменными. 

Точка привязки должна быть пересечением двух линий построения – горизонтальной 

и вертикальной прямых, остальные линии чертежа должны быть созданы относительно этих 

двух линий. 

Зарезервированные переменные можно создать двумя способами. Основной способ 

заключается в задании параметров линий построения, при этом переменная должна быть по-

мечена как внешняя, что является обязательным условием при привязке фрагмента в этих 

точках. 

Создайте новый документ с помощью команды FNew: 

 <F> <N> “Файл | Новый” 

Постройте пересекающиеся линии построения, используя команду Line и опцию . 

Не указывая мышью положения пересекающихся прямых, вызовете свойства создаваемых 

прямых выбором опции  в автоменю или с клавиатуры клавишей <P> (рисунок 53). Та-

ким образом перопределить положение пересекающихся линий можно и Редактором пере-

менных 
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Рисунок 53 – Задание параметров прямых 

 

Второй способ – используя специальную опцию . Она становится активной после 

вызова команды Line – «Построить прямую» (рисунок 54). При этом способе переменные 

создаются автоматически (они по умолчанию являются внешними переменными), а на пере-

сечении линий появляется цифра, соответствующая порядковому номеру переменной (рису-

нок 55). 

 

  

Рисунок 54 – Автоматическое создание зарезервиро-

ванных переменных 

Рисунок 55 – Маркировка пересе-

чения линий 
 

В зависимости от назначения фрагмента можно создать от 0 до 9 точек привязки. 

Обычно у фрагмента бывают одна точка привязки или две. Первая точка, как правило, задает 

положение фрагмента на чертеже, вторая – ориентацию или размер, либо и то, и другое. 

Методика привязки фрагментов, на основе точек привязки будет рассмотрена в разде-

ле создания сборки. 

Т.о. положение фрагмента, созданного по линиям построения, откладываемым от ли-

ний с координатами xn, yn будет зависеть от них и при изменении координат (переменных) 

начальных линий построения, будет изменятся положение фрагмента относительно листа. 
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ЛАБОРАТОРНАЯ РАБОТА № 5 

СОЗДАНИЕ СБОРКИ 
 

Создание сборки заключается в последовательном нанесении фрагментов (рису-

нок 56). Для того, чтобы сборочный чертеж можно было параметрически изменять, необхо-

димо «привязывать» фрагменты к узлам и задавать связи между переменными. 

 

Рисунок 56 – Схема создания сборочного чертежа из фрагментов 

Необходимо произвести сборку кривошипно-шатунного механизма (рисунок 57). 

 

 

Рисунок 57 – Составляющие звенья кривошипно-шатунного механизма 

 

Обратите внимание: Встречающиеся в описании работы названия звеньев механизма 

будут указаны в соответствии с рисунком 57. 

Для привязки фрагмента необходимо создание всех узлов, к которым будет осуществ-

ляться привязка фрагментов. Узлы создаются на пересечении линий построения или на узлах 

уже созданных фрагментов. 

Сохраните документ под именем «Сборка механизма.grb» в одну из доступных дирек-

торий. 

В созданном документе постройте пересекающиеся прямые и от горизонтальной ли-

нии отложите зависимую прямую (рисунок 58), угловое значение которой задайте перемен-
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ной как показано на рисунке 59 (для вызова параметров прямой используйте опцию  в ав-

томеню). 

  

Рисунок 58 – Построение зависимой прямой 

(угловое значение) 

Рисунок 59 – Задание параметров угла для за-

висимой прямой 

 

Из точки пересечения прямых проведите окружность радиусом L1=100, определяю-

щую расстояние между осями шарниров кривошипа (рисунок 60). 

 

 

 

 

Рисунок 60 – Построение окружности, определяю-

щей длину кривошипа 

 

Для вставки фрагментов необходимо воспользоваться командой FRagment: 

Создать фрагмент 

Клавиатура Текстовое меню Пиктограмма 

<F> <R> “Чертёж | Фрагмент”  

В автоменю выберете опцию  (рисунок 61). 
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Рисунок 61 – Открытие файла фрагмента 

 

В окне параметров фрагмента в поле «Библиотека» выбираются библиотеки или ка-

талоги, откуда должен вставляться фрагмент (рисунок 62). В поле «Просмотр» (рисунок 63) 

подсвечены точки привязки с номерами 1 и 2. В поле «Переменные» отображены внешние 

переменные, которые имеет фрагмент до вставки. Не отображаются только зарезервирован-

ные переменные, т.к. их значения задаются при привязке фрагмента к конкретным узлам. 

 

Выберете фрагмент «Кривошип.grb» из библиотеки «Л/р №7-9» (рисунки 62, 63). 

 

 

 

Рисунок 62 – Доступные библиотеки

 

Рисунок 63 – Выбор фрагмента из библиотеки 

 

После нажатия кнопки OK укажите поочерёдно местоположение первого и второго 

узла привязки (рисунок 64). 
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Рисунок 64 – Указание точек привязки Рисунок 65 – Вставленный фрагмент 

 

Изменим размеры кривошипа: наружные и внутренние диаметры шарниров, а также 

поменять межосевое расстояние. 

Все последующие фрагменты должны иметь те же диаметры, что и кривошип, поэто-

му в Редакторе переменных создадим переменные r1=14 и r2=10 (наружный и внутренний 

радиусы шарниров соответственно). 

Далее воспользуемся командой EFRagment для редактирования фрагментов: 

Изменить фрагмент 

Клавиатура Текстовое меню Пиктограмма 

<E> <F> <R> “Правка | Чертёж | Фрагмент”  

Укажите на кривошип и в появившемся автоменю выберете опцию  (рисунок 66). 

 

 

Рисунок 66 – Редактирование фрагмента 
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В появившемся окне присвойте численным значениям параметров значения r1 и r2 

(рисунок 67), численные значения которых заданы в Редакторе переменных. 

 

 

Рисунок 67 – Редактирование переменных фрагмента 

 

Т.о. если при вставке значение внешней переменной задать переменной текущего до-

кумента, то система будет каждый раз пересчитывать параметры фрагмента при изменении 

их в Редакторе переменных. Это очень удобно, так как при изменении параметров r1 и r2 в 

текущем документе, то фрагменты с такими же значениями внешних переменных также ав-

томатически пересчитаются. 

 

Ещё раз укажите на фрагмент кривошипа и выберете опцию  в автоменю. В по-

явившемся окне установите параметры фрагмента как указано на рисунке 68. 
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Рисунок 68 – Установка параметров 

 

Для того, чтобы фрагмент имел те же настройки, что заданы в статусе документа (вы-

сота шрифтов, толщина линий, стили размеров и т.д.), в поле «Использовать статус:» необ-

ходимо сделать пометку «текущего чертежа». Настройки статуса документа будут сделаны 

позже. 

Укажите пометку «По умолчанию» для применения данных настроек всем последую-

щим фрагментам данного документа. 

Длина кривошипа (см. рисунок 57) определяется параметром L1. Значение параметра 

можно поменять в Редакторе переменных текущего документа (рисунок 69): 

 <V> “Переменные” 
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Рисунок 69 – Редактирование переменных текущего документа 

 

Постройте окружность через ось шарнира как показано на рисунке 70. В параметрах 

окружности укажите значение L2=250. Данное значение будет определять радиус шатуна 

(если быть точным, то межосевое расстояние). 

 

  

Рисунок 70 – Задание радиуса шатуна Рисунок 71 – Построение прямой 

 

Далее необходимо определить местоположение поршня. Поршень должен находиться 

под углом к горизонтали на 10°. Для этого постройте зависимую прямую как показано на ри-

сунке 71 с параметром alfa2=10°. Точка пересечения данной прямой с окружностью, пара-

метр которой L2=250, есть вторая точка привязки шатуна. 

Вставьте ещё один фрагмент «Кривошип.grb» (рисунок 72). При вставке шатуна в па-

раметрах фрагмента (поле «Параметры») сразу поменяйте значения диаметров шарниров 

шатуна как у кривошипа, изменённые ранее. 

 

 

Рисунок 72 – Вставка шатуна 
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Как мы видим, фрагмент шатуна перекрывает кривошип (рисунок 72). Т.к. оба эле-

мента имеют одинаковый приоритет, то взаимное перекрытие фрагментов определяется по-

рядком их вставки. 

Следующим в сборку вставим опору, воспользовавшись командой FRagment. 

 <F> <R> “Чертёж | Фрагмент” 

Выставите параметры фрагмента как показано на рисунке 73. 

Предупреждение: при изменении значений переменных может появиться сообщение 

о неправильном пересчёте значений переменных. Игнорируйте данное предупреждение и 

продолжите ввод значений. Это связано с тем, что система автоматически делает пересчёт 

параметров и в случае потери связей выдаёт предупреждение о возможной потере данных. 

 

 

Рисунок 73 – Свойства фрагмента «Опора.grb» 

 

После указания одной точки привязки получим: 

 

 

Рисунок 74 – Вставка основания 
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Далее необходимо вставить фрагмент поршня. Направление действия поршня задаёт-

ся прямой, проходящей через точку привязки опоры и свободным концом шатуна (см. рису-

нок 74). В сборку будет включаться ранее сохранённый фрагмент с именем «Поршень 

FV.grb». Как вы помните, для ориентации фрагмента создавался вектор привязки, поэтому 

одной точки привязки не достаточно. Создадим вторую точку привязки, определяющую 

направление вектора привязки. В точке привязки поршня постройте перпендикулярную пря-

мую как показано на рисунке 75. 

 

Рисунок 75 – Построение перпендикулярной прямой 

 

От данной прямой отложите в положительном направлении на любое расстояние ещё 

одну прямую (рисунок 76). 

 

 

Рисунок 76 – Задание направления привязки фрагмента с помощью вектора привязки 

 

Для выбора фрагмента из каталога нажмите пиктограмму  в поле «Библиотека» и 

укажите путь каталога, куда был сохранён файл «Поршень FV.grb» (рисунок 77).  

На рисунке 77 в поле «Просмотр» подсвечиваются векторы привязки: красным – ак-

тивный вектор привязки, синим – неактивный. 

Поменяйте значения внешних переменных: L=58, D=52. 
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Рисунок 77 – Выбор фрагмента из библиотеки или каталога 

 

После нажатия кнопки OK укажите поочерёдно местоположение первого и второго 

узла привязки (рисунок 78). 

 

 

Рисунок 78 – Привязка фрагмента с помощью вектора привязки по двум точкам 

 

Привязку фрагмента с помощью векторов привязки основным способом осуществля-

ют по двум точкам с привязкой к конкретным узлам, этому способу соответствует опция  

в автоменю. Также, по мере необходимости, имеется возможность указывать вектор привяз-

ки в абсолютных координатах (опция ) или по одной точке и углу (опция ). 

Важно учитывать, что линии и другие элементы фрагмента не являются частью чер-

тежа, в который он включен. Это означает, что на их основе нельзя обычным способом со-

здавать другие элементы, например, размеры. Для решения этого вопроса в T-FLEX CAD 

предусмотрен специальный тип узлов – узлы с фрагмента. 

Как Вы заметили, узлы фрагментов не отображаются, но если осуществлять привязку 

к предполагаемым узлам, то они подсветятся (рисунок 79). 
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Рисунок 79 – Подсвечивание узла фрагмента 

 

Чтобы отобразить узлы фрагмента воспользуйтесь командой Node: 

 <N> “Узел” 

В появившемся автоменю выберете опцию  и укажите на нужный фрагмент (рису-

нок 80) и в изменившемся автоменю опцию  (рисунок 81). 

 

  

Рисунок 80 – Выбор фрагмента для отображе-

ния узлов 

Рисунок 81 – Подсвечивание узлов с 

фрагмента 

 

 

Далее, чтобы отобразить какой-нибудь конкретный узел, выберете опцию  и указа-

телем  отметьте необходимый узел (рисунок 82). Если нужно отобразить все узлы фраг-

мента, то после их подсвечивания выберете опцию  и все узлы фрагмента отобразятся 

(рисунок 83). 
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Рисунок 82 – Выбор узла для отоб-

ражения 

Рисунок 83 – Отображение всех узлов 

фрагмента 

 

Схематично дорисуйте направляющие поршня и поверхность на которую установлена 

опора (рисунок 84). 

 

 

Рисунок 84 – Сборка кривошипно-шатунного механизма 

 

Используя команды редактирования фрагментов, линий изображения и штриховок, 

измените приоритет отображения отдельных элементов (приоритет отображения – произ-

вольный). 

Некоторые рекомендации при работе с фрагментами сборки. 

Иногда требуется координальное изменение геометрии фрагмента с удалением эле-

ментов построения (линий узлов), при этом все зависимые построения в сборке требуется 

сохранить. Поэтому важно сказать о том, что все построения, выполненные с использовани-

ем узлов фрагмента «привязаны» именно к той геометрии, которую имел фрагмент на мо-

мент вставки; это вовсе не означает, что при изменении параметров фрагмента, при его от-

крытии, будут потеряны связи. Если всё же координальное изменение фрагмента неизбежно, 

то рекомендуется сохранить редактируемый фрагмент под другим именем, а в сборке пога-
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сить с помощью изменения уровней видимости или слоёв. 

При редактировании фрагментов имеется возможность их «раскрытия» (опция ). 

Данной функцией следует пользоваться лишь в тех случаях, когда местоположение фрагмен-

та и параметры его определены, т.к. параметрические зависимости между линиями изобра-

жения теряются и изменение фрагмента с помощью переменных невозможно. 

При работе со сборками следует учитывать, что файл сборке не содержит в себе гео-

метрические зависимости фрагментов (кроме случая с раскрытыми фрагментами), а только 

содержит ссылки на них. Поэтому копирование сборки нужно осуществлять вместе с фраг-

ментами. 
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ЛАБОРАТОРНАЯ РАБОТА № 6  

СОЗДАНИЕ АНИМАЦИИ ДВИЖЕНИЯ СБОРОЧНОГО МЕХАНИЗМА 

 

Система T-FLEX CAD позволяет создавать анимацию чертежей, посредством поша-

гового изменения какого-либо параметра, заданного переменной. Одновременно происходит 

перерисовка чертежа на каждом шаге. 

Рассмотрим создание анимации для кривошипно-шатунного механизма, сборка кото-

рого осуществлялась ранее. Положение механизма зависит от значения параметра линии по-

строения на основе которой создан кривошип. Т.о. периодически меняя значение линии по-

строения с параметром угла «alfa1», получится анимация механизма. 

Для создания анимации воспользуйтесь командой: 

Анимация 

Клавиатура Текстовое меню Пиктограмма 

<A> <N> “Параметры | Анимация”  

 

При входе в команду на экране появляется диалоговое окно параметров команды (ри-

сунок 85). После нажатия ОК отобразится механизм в разных положениях (рисунок 86). Для 

прекращения анимации во время работы нажмите <Esc>. 

 

 

Рисунок 85 – Параметры анимации 

 

Для анимации могут быть установлены следующие параметры: 
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Имя переменной. Вы можете задать имя переменной, значение которой будет изме-

няться (кроме текстовой переменной). 

Начальное значение. Значение переменной, с которого начнется ее изменение. 

Конечное значение. Значение переменной, при котором закончится выполнение ко-

манды. 

Шаг. Число, которое будет прибавляться к значению переменной на каждом шаге 

анимации. 

Очистка экрана. При задании данной опции, на каждом шаге экран будет очищаться. 

В противном случае, изображение будет накладываться и вы сможете увидеть динамику 

движения и изменения чертежа на каждом шаге. 

Смена цвета. При задании данной опции, изображение на каждом шаге будет отоб-

ражаться разным цветом. Эта опция полезна, если вы хотите сравнивать различные результа-

ты при изменении значений параметров чертежа. 

Пауза. При задании данной опции после перерисовки чертежа на каждом шаге систе-

ма потребует от вас подтверждения очередной прорисовки. 

Создать метафайл. При задании данной опции, изображение, получаемое в результа-

те анимации, будет сохранено в чертеже-метафайле. Затем можно вывести метафайл на 

принтер или плоттер, включить его в чертеж T-FLEX CAD или экспортировать в другой 

формат. Отметим, что при включенном режиме «Очистка экрана» вывод в метафайл не 

осуществляется. 

При установке параметра Создать мультимедиа файл можно создавать файлы фор-

мата (*.avi), здесь же задается «Имя файла» и «Количество кадров в секунду». Кнопка 

[Сжатие] выводит на экран окно диалога для выбора программы сжатия, либо для записи 

полных кадров (сжатия) и задания параметров сжатия. 
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Рисунок 86 – Анимация механизма 

 

Установите параметры анимации как показано на рисунке 85 и нажмите OK. 

Сохраните результаты работы в одну из доступных директорий. 
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КОНТРОЛЬНЫЕ ВОПРОСЫ 
 
1. Понятие компьютерной графики. Типы графических редакторов, назначение. 
2. Компоненты графических систем  
3. Понятие модели, геометрической модели и геометрического объекта. Проблемы ре-
ализации систем геометрического моделирования. 
4. История развития систем геометрического моделирования. Возникновение систем  
плоского  и  объемного  моделирования.  
5. Автоматизированная разработка  конструкторской и технологической докумен-тации. 
Организация производства и системы автоматизированного проектирования 
6. Требования  к  процессу геометрического моделирования в САПР. 
7. Базовые и прикладные средства графических систем. Графические системы  САПР,  
ориентированные  на  чертеж.   
8. Способы создания геометрических моделей в САПР. 
9. Виды простейших геометрических элементов и основные способы их создания в 
САПР.   
10. Базовые и прикладные средства графических систем. Графические системы  САПР,  
ориентированные  на  чертеж.   
11. . Графические  системы САПР, ориентированные на объект. Задачи  графических  си-
стем САПР.  
12. . Связь подсистем САПР с точки зрения обработки графической и геометрической 
информации.  
13. .Функции графических систем САПР. Компоненты  графических  систем  САПР.   
14. . Технические  средства  интерактивной графической системы. Архитектура про-
граммных средства графических систем.   
15. . Примеры современных графических систем.  
16. . Примеры систем подготовки чертежно-конструкторской документации. Примеры 
систем подготовки инженерной документации.  
8.Примеры  систем  машинного  конструирования.  Примеры  систем  обработки графиче-
ской и  геометрической информации. 
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